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What is 3CX Phone System for Windows? 
3CX Phone System is a software based PBX for Windows that works with SIP standard based IP                                 
Phones, SIP Trunks and VoIP Gateways to provide a complete PBX solution – without the inflated                               
cost and management headaches of an ‘old style’ PBX. The IP PBX supports all traditional PBX                               
features but also includes many new mobility and productivity features. An IP PBX is also referred to                                 
as a VoIP Phone System or SIP Server. 
 
Calls are sent as data packets over the computer data network instead of the traditional phone                               
network. Phones share the network with computers so no separate phone wiring is required. With                             
the use of a VoIP/PSTN gateway, you can connect existing phone lines to the IP PBX to make and                                     
receive phone calls via a regular PSTN line. You can also use a VoIP Provider, which removes the                                   
requirement for a gateway. 
 
3CX Phone System interoperates with standard SIP softphones, IP phones or smartphones, and                         
provides internal call switching, as well as inbound and outbound calling via the standard phone                             
network or via a VoIP service. 
 
How an IP Phone System Works 
A VoIP Phone System generally consists of the IP PBX server, one or more SIP based phones and                                   
a VoIP/PSTN Gateway or a VoIP service provider. The IP PBX server is similar to a proxy server.                                   
SIP clients, being either softphones or hardware based phones, register with the IP PBX server.  
When they wish to make a call they ask the IP PBX to establish the connection. The IP PBX has a                                         
directory of all phones/users and their corresponding SIP address, and connects an internal call or                             
routes an external call via either a VoIP/PSTN gateway or a VoIP service provider. 



   
Figure  VoIP Phone System Overview 

 
The image illustrates how an IP PBX integrates with the network and how it uses the PSTN and/or                                   
the Internet to connect calls. 
 
SIP Phones 
A VoIP phone system requires the use of SIP Phones. These phones are based on the Session                                 
Initiation Protocol (SIP), an industry standard to which all modern IP PBX systems adhere to. The                               
SIP protocol defines how calls should be established and is specified in RFC 3261. SIP allows the                                 
possibility to mix and match IP PBX software, phones and gateways. This protects your investment                             
in phone hardware. SIP phones are available in several versions/types: 
 



Software (based) SIP Phones 

 
3CXPhone for Mac (left), 3CXPhone for Windows (right) 

 
A software based SIP phone is a program which makes use of your computer's microphone and                               
speakers, or an attached headset to allow you to make or receive calls. Examples of software SIP                                 
phones are 3CXPhone or XLite from Counterpath. 
 
Hardware (based) SIP Phones 

    
Hardware IP Phones: snom 760 left, Yealink T46G right 

 
Hardware based SIP phones look and behave like normal phones. They are actually mini computers                             
that connect directly to the computer network. They have an integrated mini hub, allowing them to                               



share a network connection point with a computer, eliminating the need for an additional network                             
point for the phone. 
 
Smartphones (iOS and Android) 

 
Using an iPhone or Android Smartphone with 3CX 

 
iOS and Android devices can be used as clients for 3CX Phone System, using the freely available                                 
3CXPhone for Android and 3CXPhone for iOS. Using 3CXPhone, your smartphone or tablet                         
becomes a wireless desk phone in the office, and can be used to answer and receive company calls                                   
while out of the office via WiFi, 3G or 4G(Providing your mobile service provider supports VoIP over                                 
3G and/or 4G). 
 
3CX Phone System Licensing 
Licensing is based on the number of simultaneous calls that your company requires, including both                             
external and internal calls. Each 3CX Phone System allows you to create an UNLIMITED number of                               
extensions. To arrive at the correct number of simultaneous calls that you will need you must                               
usually take the projected number of extensions and divide by two to four times depending on how                                 
much your organisation uses the phone. 
 
3CX Phone System Editions 
3CX Phone System is available in three different editions: 
 

● Free Edition  All features but limited to two simultaneous calls 
● Standard Edition – Includes all key features necessary.  
● PRO Edition  Adds advanced call queueing, reporting, CRM integration and more. 

 
Find out more about the differences between versions from our Features Comparison Page. 
 
Support 
3CX Technical Support is available via our Support Portal. Access is free for 3CX Partners. For end 
users, 3CX Support packages are available. Review our Support Procedures and Pricing. We also 

http://www.3cx.com/phone-system/edition-comparison/
http://support.3cx.com/
http://www.3cx.com/ordering/procedures


have Community Forums from where you can obtain user to user support for our products. 
 
Support Page / Configuration Guides / Knowledge Base 
3CX maintains a knowledge base / help page. Be sure to follow the configuration guides for the                                 
make and model of your VoIP gateway, SIP phone or Firewall. The configuration guides can be                               
found in the main Support Page. 

See Also 
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System Requirements 
 
Supported Operating Systems 
3CX Phone System v14 is supported on the following operating systems:  
 

● Windows 7 Professional (x64) 
● Windows 7 Ultimate (x64) 
● Windows 7 Enterprise (x64) 
● Windows 8 Pro (x64) 
● Windows 8 Enterprise (x64) 
● Windows 8.1 Pro (x64) 
● Windows 8.1 Enterprise (x64) 
● Windows 10 Pro (x64) 
● Windows 10 Enterprise (x64) 
● Windows 2008 R2 Foundation (x64 only) 
● Windows 2008 R2 Standard (x64 only) 
● Windows 2008 R2 Enterprise (x64 only) 
● Windows 2008 R2 Datacenter (x64 only) 
● Windows 2012 Foundation (max. 15 presence connections on IIS installations) 
● Windows 2012 Standard 
● Windows 2012 Datacenter 
● Windows 2012 R2 Essentials (max. 25 presence connections on IIS installations) 
● Windows 2012 R2 Standard 
● Windows 2012 R2 Datacenter 



Installations on Microsoft Windows Server Core versions are not supported. It should be noted that                             
on client operating systems Windows 7, 8, 8.1 and 10, Abyss will be used as the web server,                                   
whereas on Windows Server, IIS will be used. 
 
Supported Hardware and VM Platforms 
3CX Phone System is extensively tested to be run as a VM which eliminates the cost of separate                                   
hardware and adds high availability solutions based on the hypervisor infrastructure. Supported                       
hypervisor platforms are: 
 

● VMware ESX 5.X and above. 
● Microsoft HyperV 2008 R2 and above. See our HyperV Page for the specific settings for 

running 3CX Phone System. 
 
Avoid using 3CX Phone System on converted VMs (P2V) because a converted virtual machine                           
might have timing issues, which causes the guest operating system not to sync with the timer of the                                   
hypervisor.  
 
System performance depends on five key factors: 

● How many simultaneous calls will the system handle. 
● How many people will simultaneously connect to the presence server. 
● If call recording is used. 
● If VoIP Providers are used. 
● If call routing built is mainly around queues and IVRs. 

 
Based on these factors the hardware can vary from Intel i3 CPUs with 4Gb of RAM up to a multi                                       
socket/core system. General guidelines can be found online in these articles:  

● Recommended Hardware Specifications for 3CX Phone System 
● Large Enterprise Deployments 

 
Firewall & Network Considerations 
3CX Phone System allows two network topology deployment options: 
 

● No NAT  no NAT is performed from public to a private network. The Network card’s IP                                 
address would be a public IP.  

● Behind NAT  a firewall / router is between the internet and the PBX which performs network                                 
address translation. The Network card’s IP address would be a private IP.  

No NAT Firewall Configuration 
In case of “No NAT”, it is sufficient to use the built In “Windows Firewall” to secure the machine. You                                       
do not need to do anything as the 3CX Phone System installation will open all the required ports                                   
automatically.  
 
NAT Mode Firewall Configuration 
If 3CX Phone System is installed behind a NAT device, ports need to be forwarded. See the                                 
following guides detailing the requirements: 
 

● The Firewall & Router Configuration Guide provides details on which ports to open.  
● See also Ports Used by 3CX Phone System for the list of required ports that need to always                                   

be available (not used by any other service). 

http://www.3cx.com/docs/installing-microsoft-hyper-v/
http://downloads.3cx.com/downloads/3CX_Phone_System_Operating_System_Specifications.pdf
http://www.3cx.com/blog/news/3cx-phone-system-for-large-enterprises/
http://www.3cx.com/docs/firewall-router-configuration-voip/
http://www.3cx.com/docs/3cx-phone-system-v14-ports/


Other requirements 
● Latest version of Firefox, Google Chrome or Internet Explorer. 
● Microsoft .NET Framework version 4.5 or higher. 
● You will need to have a good basic understanding of Windows Networking. 
● A constant internet connection to erp.3cx.com on port 443. 
● On demand connection to downloads.3cx.com/* on port 80 for 3CX Management Console                       

downloads and additional information. 

FQDN for the 3CX Phone System machine 
An FQDN is required for the following reasons: 

● Easy access to the 3CX Management Console. 
● For easy management of IP phones and services in case of an IP change. 
● To setup HTTPS for the console. 
● To securely provision IP phones using HTTPS. 

 
The FQDN must resolve on your LAN to the machine on which 3CX Phone System is installed, and                                   
from the internet it must resolve to your Public IP. You can choose to have a separate FQDN for                                     
internal and external connections or a single FQDN for both using Split DNS. Find more information                               
on how to Create FQDN using Split DNS. 
 
Preparing the Windows Host Machine for Installation 
Tasks that MUST be completed before installing 3CX Phone System: 

● Assign a static internal IP address to the host machine’s network adapter. 
● Install all available Windows updates & Service packs before installing 3CX Phone                       

System. The reboot after installing Windows updates may reveal additional updates. Pay                       
particular attention to install all updates for Microsoft .Net before running the 3CX Phone                           
System installation. 

● Antivirus Software should not scan the following directories to avoid complications and write                         
access delays: 

● C:\Program Files\3CX PhoneSystem\* 
● C:\ProgramData\3CX\* 

 
In case the 3CX Phone System host machine has multiple network adapters: 

● Disable unused network interfaces / WiFi adapters. 
● One active network interface MUST have a default gateway configured. It is illegal                         

and wrong to have multiple network interfaces all with default gateways configured. 
● Prioritize the primary network interface (the one with the default gateway configured)                       

to the first position from: “Control Panel” > “Network and Internet” > “Network                         
Connections”. Press the Alt key to reveal the File menu and click on “Advanced” >                             
“Advanced Settings”. The “Adapter and Bindings” tab > “Connections” section                   
will show your interfaces. Ensure that the network card with the default gateway is at                             
the top. 

http://www.3cx.com/docs/creating-fqdn-split-dns/


 
Additionally: 

● Do not install VPN software on your 3CX Server 
● Ensure that all power saving options for your System and Network adapters are disabled                           

(Set the system to High Performance).  
● Do not install TeamViewer VPN Option on the host machine. 
● Disable Bluetooth adapters if it is a client PC. 
● 3CX Phone System must not be installed on a host which is a DNS or DHCP server, has MS                                     

SharePoint or Exchange services installed. 
 
Installing 3CX Phone System 
 

1. Download the latest version of 3CX Phone System. 
2. Doubleclick on the setup file. Read the system requirements. Click “Next”. 
3. Read our configuration recommendations. Click “Next”. 
4. You will be asked to review and accept the license agreement.  
5. Select the installation folder path, 3CX Phone System will need a minimum of 10GB free                             

hard disk space. You will need to reserve additional space to store voicemail files,                           
recordings & voice prompts. Choose the location to install and then click “Next”. 

 

http://www.3cx.com/phone-system/download-phone-system


 
 

6. Select the Phone System Installation mode, select Standard Installation (Single Instance).                     
Click “Next”. 
● For the Virtual PBX Installation (Multiple Instance)  See Installing 3CX Phone System as 

a Virtual PBX Server. 
 

 
 

7. Select whether 3CX Phone System is about to be installed on a machine which is directly on                                 

http://www.3cx.com/docs/virtual-pbx-installation/
http://www.3cx.com/docs/virtual-pbx-installation/


the internet (no NAT configured  where the result of “ipconfig” command will result a public                               
ip) or whether the server is behind a NAT device (NAT configured  where the result of                                 
“ipconfig” command will result a local ip). Select the appropriate option and click “Next”.  

 

 
 

8. You will now need to enter your Static Public IP Address, type it in and click “Next”.                                 
Furthermore check that the installation has detected the correct default network card.   

9. Enter your Server Administrator Email Address that will receive notifications. Click “Next”. 
 



 
 

10. Specify the FQDN of the machine on which you will be installing 3CX Phone System: 
● Single FQDN, for example: “pbx.interobit.com”. The FQDN must resolve on your LAN to                         

the machine on which 3CX Phone System is installed, and from the internet it must                             
resolve to your Public IP. If the domain is not dedicated to the PBX and subdomains are                                 
used for other services, such as www.interobit.com, then you will need to use Split DNS                             
on your router/DNS Server. Alternatively you can dedicate a cheap domain to your PBX.                           
More information on how to Create FQDN using Split DNS. 

● External FQDN and Local FQDN, for example pbx.interobit.com & pbx.interobit.local. If                     
you do not want to dedicate a domain or use Split DNS, you can select to use a separate                                     
external /local FQDN. The external FQDN will be used for devices connecting from                         
outside the LAN. Not recommended, because this complicates provisioning and slows                     
connecting of the clients (as it can not rely on DNS but instead has to check both URLS).                                   
If you do not have the ability to create a local FQDN for the LAN , then you can enter the                                         
IP Address in the local FQDN field. 

● No FQDN  If you do not want to connect to the PBX from outside the LAN, you can                                     
specify a local IP. IP phones or clients can not be used outside the LAN. Abyss must be                                   
used as the web server. 

11. Fill in the details of your SMTP server that will be used to send out email notifications. Click                                   
“Next”. 

12. Now specify the Management Console username and password. Make sure to use a strong                           
password to prevent unauthorised access to your PBX. Usernames and passwords are both                         
case sensitive. Click “Next”. 

13. 3CX Phone System requires a web server, “Microsoft IIS” or a bundled web server “Abyss”.  
● If installing on a Server OS then IIS is the best solution.  
● If you checked the option “I do not have an FQDN”, Abyss will be automatically selected. 
● Abyss will be automatically selected if 3CX is installed on a client desktop OS (Windows                             

7, 8, 8.1, 10).  
● If ports 80 or 443 are already in use by another service on the same host, then you must                                     

http://www.mydomain.com/
http://www.3cx.com/docs/creating-fqdn-split-dns/


● If ports 80 or 443 are already in use by another service on the same host, then you must                                     
select Abyss because you can configure different ports for HTTP and HTTPS. The IIS                           
option in 3CX does not allow you to edit web ports and are hardcoded to 80 and 443. 

14. If Abyss is selected, you will have the ability to change the http and https ports that the web                                     
server will listen on. Accept the defaults (http: 5000, https: 5001) or type in your own. 

 

 
 

15. If you have an SSL Certificate for the FQDN or domain that you entered, select “Import an                                 
SSL Certificate”. Otherwise you can choose the option to generate a selfsigned certificate. 

 



 
 

16. The above image shows the Import Trusted SSL Certificate. Here you should import a “pfx”                             
file and enter the certificate password in the Password field. If in Step 15 you chose “I do not                                     
have an SSL Certificate  generate one for me”, you will be asked for a company name and                                   
a certificate password so the certificate can be generated on the fly.  

 

 
 

17. Click “Install” to start the installation of 3CX Phone System. Setup will now copy all files                               



and install the necessary Windows services.  
 
Running the 3CX Phone System Configuration Wizard 
The 3CX Phone System configuration wizard will walk you through a number of essential tasks that                               
you need to do in order to get your system up and running.  
 

1. After installation is complete, double click the 3CX Management Console icon from your                         
desktop.  

2. Enter the username and password that you specified during setup, select the language you                           
would like to use and click the “Login” button. Note that the username and password are                               
both case sensitive. The "Configuration Wizard" will be displayed which will walk you                         
through the initial configuration step by step.   

 
3. Choose the number of digits that extension numbers should have. This cannot be altered                           

later. Click “Next”.  



 
4. Select your country and time zone settings and click “Next”. 

 
5. Configure the Operator Extension by entering first name, last name and email address. This                           

is the default destination for inbound calls. Confirm that the VoiceMail Extension number is                           
appropriate for your installation and click “Next”. 



 
6. Specify the countries or regions to which calls can be made. Calls to countries which are not                                 

selected will be blocked. This feature reduces the risk of VoIP toll fraud. Select the countries                               
you would like to allow and click “Finish”. 

 
You have now completed the initial configuration of 3CX Phone System. You will be redirected to                               
the quick 3CX Phone System Management Console. The Quick Start page will show you the next                               
steps you will need to take. 
 

 
 



Upgrading From a Previous Version of 3CX Phone System 
If you are running an old version of 3CX Phone System (9, 10) you must upgrade to v11 SP 4a, and                                         
then to v12 SP 6.1 before following this upgrade procedure. If you are using 3CX Phone System                                 
v12 SP 6.1 or v12.5 you can go to v14 directly.   
 
If upgrading from 12.5 ask your users to upgrade their 3CXPhone clients to the latest version to                                 
ensure in place updating to v14. See our guides with instructions for installing and upgrading                             
3CXPhone Clients for Windows, Android, iOS and Mac. 
 
Step 1: Backup your configuration & Uninstall the old version 

1. Make a backup of your current configuration using the 3CX Backup and restore tool.  
2. Tick the options to include in your backup, then choose where to save your backup.                             

Warning: Do not choose to store the backup inside any of the 3CX Phone System                             
installation folders as these folders are removed during the uninstall process.  

3. Uninstall the current version from the Windows Control Panel > Programs and Features. 
 
Step 2: Install 3CX Phone System v14 

1. Download 3CX Phone System Version 14 
2. Proceed with the installation as documented above. 
3. Complete the 3CX Configuration Wizard. 

 
Step 3: Restore your configuration 

1. Go to the 3CX Management Console 
 

 
2. Go to the “Backup and Restore” node. Click on the “Location” button. Select the location                             

where your backups are stored (Local Disk or FTP) and configure the “Select folder path”                             
to the folder where your backup is located. Press OK. After this you should see the backup                                 
from the location together with the backup details and size.   

http://www.3cx.com/user-manual/installation-windows/
http://www.3cx.com/user-manual/installation-android/
http://www.3cx.com/user-manual/installation-iphone/
http://www.3cx.com/user-manual/installation-mac/
http://downloads.3cx.com/downloads/3CXPhoneSystem14.exe


 
3. Select the backup you want to restore and click “Restore” button from the toolbar.  
4. The management console will log out and the restore process will start. When the restore is                               

complete, an email will be sent to the Administrator email configured during the setup. This                             
means that the restore completed, was successful and you can login to the 3CX                           
Management console.   

Activating your License 
Without a license, 3CX Phone System will work for up to 2 simultaneous calls. If you require more,                                   
then you will need to activate a license. There are two ways to access the activation page in order to                                       
activate a license, you can either click on the “Activate License” link in the Quick Start page or                                   
directly from the “Settings” > “Activate License” node, from within your 3CX Management                         
Console.  
 

 
 

Enter your License Key, Company, Contact Name, Email, Telephone, Country and the name of                           
your Reseller (The company who you bought 3CX from) and click on “Activate” to activate your                               
license.   
 



● This information will be sent to our license key server to activate your license key.  
● To be entitled to your first year of free upgrade insurance, your details must be correct.                               

These details are reviewed by 3CX and if they are not correct the upgrade insurance will not                                 
be activated. 

 
If you license your 3CX Phone System and then reinstall on a new machine, change hardware, or                                 
the local network topology changes (for example the local MAC address changes), you will need to                               
reactivate your licenses.  
 
Note: Packets between the 3CX Phone System server and erp.3cx.com should not be filtered or                             
inspected. If you run DPI (Deep Packet Inspection), license key activations will be rejected. 
 
System Prompts Language 
3CX Phone System ships with a US English prompt set by default. Prompts are recorded voice files                                 
that are played by the system to callers and users of the system. For example, when a user picks up                                       
their voice mail, the system prompts will instruct the user what buttons to press in order to hear or                                     
delete voice messages. To change the system prompts to a different language: 
 

1. Go to “Updates” > “System prompt sets” node, select the prompt set you wish to use and                                 
click on “Download Selected”. The prompt set will be downloaded to your machine. 
Note: Download only the prompt set that you need. 

2. Go to “Settings” > “System prompts” > “Manage Prompt sets” at the top of the screen. 
3. Select the prompt set that you have downloaded and click on “Set As Current Prompt                             

Set”. The system will now use this new prompt set. 
 
See Also 

● See our guides with instructions for installing and upgrading 3CXPhone Clients for Windows,                         
Android, iOS and Mac.  

● Find instructions here on installing 3CX Phone System as a Virtual PBX Server. 
● See the HyperV Page for the specific settings for running 3CX Phone System on Hyper V. 
● Check Ports used by 3CX Phone System for the list of ports that must always be available. 
● The Firewall & Router Configuration Guide provides details on which ports to open. 
● Recommended Hardware Specifications for 3CX Phone System. 
● See our guide on how to use the Backup & Restore feature within the 3CX Management                               

Console. 

 

 

 

 

 

 

http://www.3cx.com/user-manual/installation-windows/
http://www.3cx.com/user-manual/installation-android/
http://www.3cx.com/user-manual/installation-iphone/
http://www.3cx.com/user-manual/installation-mac/
http://www.3cx.com/docs/virtual-pbx-installation/
http://www.3cx.com/docs/installing-microsoft-hyper-v/
http://www.3cx.com/docs/3cx-phone-system-v14-ports
http://www.3cx.com/docs/firewall-router-configuration-voip/
http://www.3cx.com/downloads/3CX_Phone_System_Operating_System_Specifications.pdf
http://www.3cx.com/docs/backup-restore/
http://www.3cx.com/user-manual/installation-mac/


Firewall & Router Configuration 
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See Also 

 
Introduction 
If you plan to use remote extensions or a VoIP Provider, you will have to make changes to your                                     
firewall configuration. In order for 3CX Phone System to communicate successfully with VoIP                         
providers and remote extensions, your firewall/router device must be correctly configured for SIP                         
operation. You can learn more about Routers, NAT, VoIP and Firewalls in this article. 
 
SIP ALG 
To maximize your chances of success, make sure you choose a device that does not implement a                                 
SIP Helper or SIP ALG (Application Layer Gateway), or choose a device on which SIP ALG can be                                   
disabled. The following links are examples of how to switch off ALG on popular routers: 
 

● How to Disable SIP ALG on Fortinet / FortiGate  
● How to Disable SIP ALG on Netgear Routers 
● How to Disable SIP ALG on Thomson Routers 

 
Configuration for VoIP Provider or SIP Trunk 
If you intend to use a VoIP Provider & the 3CX WebRTC Gateway you will need to open the                                     
following ports to allow 3CX Phone System to communicate with the VoIP Provider: 
 

● Port 5060 (UDP) for SIP communications (send & receive) MUST BE STATICALLY 
MAPPED. See sample firewall configuration.  

● Port 5061 (TCP) for TLS communications – If using secure SIP. 
● Port 90009500 (or higher) (UDP) (send & receive) for RTP communications, which contain                         

the actual call. Each call requires 2 RTP ports, one to control the call and one for the call                                     
data. Therefore, you must open twice as many ports if you wish to support simultaneous                             
calls via the VoIP Provider. For example, if you want to allow 4 people to make calls via the                                     
VoIP provider simultaneously, you must open port 9000 to 9007. 

 
Configuring ports to allow PUSH messages to smartphones 
PUSH messages are sent by 3CX Phone System to Extensions using smartphones in order to wake                               
up the devices to take call. This greatly enhances the usability of the smartphone clients but                               
requires configuration of the firewall to allow outbound PUSH messages. 

http://www.3cx.com/blog/voip-howto/firewall-nat-pat-stun/
http://www.3cx.com/blog/Docs/Disable-SIP-ALG-on-FortiGate/
http://www.3cx.com/blog/Docs/Disable-SIP-ALG-on-Netgear/
http://www.3cx.com/blog/docs/disable-sip-alg-on-thomson/
http://www.3cx.com/blog/voip-howto/linksys-router-configuration/


Configuration for Remote Extensions 
For remote extensions, you have the choice of using 3CX SBC (Tunnel) or using Direct SIP. The                                 
3CX SBC service will bundle all VoIP traffic over a single port and vastly simplify firewall                               
configuration and improve reliability. 3CXPhone for Android, iOS, Windows and Mac have the inbuilt                           
tunnel, whilst using the 3CX SBC service on a remote network you can also connect IP phones via                                   
the tunnel. More information on SBC can be found in the next chapter. 
 
Remote Extensions via 3CX Tunnel 
To connect remote extensions via the 3CX Tunnel, you must open the following ports: 
 

● Port 5090 (UDP and TCP). 
● Port 80 HTTP / 443 HTTPS for 3CXPhone Presence and Phone Provisioning.  

 
Note: HTTP and HTTPS ports can be configured during installation. If you have chosen to use 
custom ports other than 80/443 make sure to forward those. 
 

 
 
Remote Extensions via direct SIP 
If you wish to connect remote extensions via direct SIP, you must open the following ports: 
 

● Port 5060. 
● Port 5061 if using secure SIP. 
● Port 90009255 for RTP. 
● Port 80 HTTP / 443 HTTPS for 3CXPhone Presence and HTTP provisioning. Note: HTTP 

and HTTPS ports can be configured during installation. If you have chosen to use ports other 
than 80/443 make sure to forward those. 

 

 
 
Configure WebRTC Ports 
To be able to configure WebRTC call links, you need to make sure that you have a Public IP                                     
Address and configure your FQDN correctly during the setup of your 3CX Phone System. 3CX                             
WebRTC gateway requires ports 92569499 UDP to be opened on your firewall/router and                         
forwarded to your PBX. 
 
You can open and forward all the ports required by the media server, in one go, by opening the                                     
range: UDP 90009499.  



 

 
 
Note that the above port ranges are the default ports in 3CX Phone System. You can adjust these                                   
ports from the 3CX Management Console, in the “Settings” > “Network” node. From here, you                             
can configure the ports to be used for internal calls, and the ports to be used for external calls being                                       
made via a VoIP Provider or calls to and from a remote extension. 
 
Firewall checker 
After configuring your firewall, run the 3CX firewall checker to ensure that configuration is correct.  
 
See Also 
Example configurations for popular firewalls: 

● Configuring a Sonicwall Firewall for 3CX Phone System 
● Configuring a Draytek 2820 Router for 3CX with QoS configuration 
● Configuring a Zyxel P662HD1 Router with 3CX Phone System 
● Configuring AVM FritzBox as a Firewall with 3CX Phone System 
● Configuring a CISCO router to allow connection to a VOIP provider 
● Configuring Linksys router for 3CX Phone System 
● Configuring FortiGate 80C for 3CX Phone System 
● Configuring a WatchGuard XTM Firewall for 3CX Phone System 
● Configuring a pfSense Firewall for 3CX Phone System 
● Configuring a pfSense Firewall for 3CX Phone System as a Virtual PBX Server 
● Configuring a Kerio Control Appliance for 3CX Phone System 
● Configuring a TechniColor Router for 3CX Phone System 

http://www.3cx.com/blog/docs/firewall-checker/
http://www.3cx.com/blog/voip-howto/sonicwall-firewall-configuration/
http://www.3cx.com/blog/voip-howto/draytek-firewall-voip/
http://www.3cx.com/blog/docs/zyxel-router-3cx/
http://www.3cx.com/blog/docs/avm-fritzbox-firewall-voIP/
http://www.3cx.com/blog/voip-howto/cisco-voip-configuration/
http://www.3cx.com/blog/voip-howto/linksys-router-configuration/
http://www.3cx.com/blog/voip-howto/fortigate-80-alg/
http://www.3cx.com/blog/voip-howto/watchguard-xtm-firewall/
http://www.3cx.com/blog/voip-howto/pfsense-firewall/
http://www.3cx.com/docs/virtual-pbx-firewall-setup/
http://www.3cx.com/blog/voip-howto/kerio-control-configuration/
http://www.3cx.com/blog/voip-howto/technicolor-router-configuration/
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Introduction 
3CXPhone is a softphone & client that allows users to easily manage their extension with a few                                 
mouse clicks – rather than via a cryptic and limited hardware phone interface. 3CXPhone can work                               
alongside an existing supported IP phone or you can use the inbuilt softphone. 3CXPhone is                             
available for multiple platforms including Windows, Android, iOS and Mac. 
 



 
 

3CXPhone provides the following functions: 
● Call Popup – Upon receiving a call, 3CXPhone will allow you to answer or reject the call,                                 

transfer the call to another person or to voice mail  with a single mouse click or by using                                     
drag and drop. 

● Easy Call Transfer / Park – Transfer or park a call with a mouse click or via drag and drop,                                       
no need to learn dial codes or call transfer procedures on a phone. 

● Presence – View statuses of other extensions and avoid unnecessary calls.  
● Click to Call – Colleagues, numbers in web pages or contacts in CRM software. 
● Hot key Dialling – Place/control calls using configurable keyboard shortcuts. 
● Queue Monitoring –  View the status of queues that you are a member of or a manager. 
● Call Monitoring  See callers waiting in queue and be able to pick up a call. 
● Text Chat – Message other users one to one or create multi user chat. 
● Record Calls  –  You can record a call by clicking the record button. 
● Phonebook – 3CXPhone provides easy access to the company and personal phonebooks.  

 
Softphone or CTI Mode 
3CXPhone can run in two different modes: 
 

● Softphone Mode (All platforms) – Allows you to make and receive calls on your computer                             
or mobile device without using a deskphone. It uses a built in SIP engine to place the calls                                   
and uses the device’s microphone and speakers. In softphone mode 3CXPhone can handle                         
up to 5 simultaneous calls and supports blind and attended transfer. 

● CTI Mode (3CXPhone for Windows only) – Allows you to control your hardware IP phone                             
from your Windows desktop with a few mouse clicks. When in CTI Mode 3CXPhone can                             



handle one simultaneous call and supports blind and attended transfer. In this mode, HTTP                           
commands are sent directly to the IP phone that is registered to the extension to control the                                 
functionality of the phone. When in CTI mode you will see the number you are attempting to                                 
dial on the IP phone’s display and hear the standard ringback tones.  

 
Note:  

● To use CTI Mode, you should make sure that in your “Extensions” node “Extension                           
settings” > “Forwarding rules” > “Available” tab, the option “I want to be able to accept                               
more than one call at the same time” is not enabled.  

● CTI Mode can only be used on the local LAN where 3CX is installed.  
 
If your IP phone does not support CTI, then the CTI Mode will use the so called “MakeCall”                                   
functionality. The most noticeable difference between CTI and “MakeCall” mode is shown when                         
starting a call from call history entries. When you start a call using “MakeCall” the desktop IP phone                                   
will be called from 3CX Phone System and on the phone’s display you will see “MakeCall”. After you                                   
pick up the handset the call will be placed on hold and a call to the destination is made from 3CX                                         
Phone System. Once the receiving end answers the call, music on hold will stop and the call will                                   
connect to the callee.  
 
Supported Client Operating Systems & Info 
 
Microsoft Windows 
3CXPhone for Windows is tested and supported on the following Windows versions:  
 

● Windows 7  
● Windows 8  
● Windows 8.1 
● Windows 10  

 
Additional information: 

● Microsoft .Net 4.5. 
● More information about the Windows Client Installation. 
● Once installed and provisioned, 3CXPhone gets updated automatically with the service                     

packs of 3CX Phone System.  
● The user manual can be found here. 
● You can deploy the 3CXPhone MSI file via active directory. You must also deploy the                             

“Microsoft Visual C++ 2010 x86” msi package on x86 and x64 clients. 
 
iOS 
3CXPhone for iOS is optimized for iPhone 6. 

● iOS 8 
● iPhone 4S, iPhone 5, iPhone 5s, iPhone 6, iPhone 6s 
● iPod touch (3rd generation), iPod touch (4th generation), iPod touch (5th generation). 
● iPad & iPad Mini all models. 

 
Additional information: 

● The 3CXPhone App requires read only access to the local device (phone) to compose a                             
unified address book of all contacts. For allowing access to contacts, go to “Settings” >                             
“Privacy” > “Contacts” > 3CXPhone 14 and set to on . 

● In order to receive Push messages it must also be allowed to send “Notifications” to the                               

http://www.3cx.com/user-manual/installation-windows/
http://www.3cx.com/user-manual/


device. For notifications, go to “Settings” > “Notifications” > “3CXPhone 14” and enable                         
“Allow Notifications”.  

● More information can be found here about the iOS Client Installation. 
● The user manual can be found here. 

 
Android 

● Android 4.X and higher 
● Important: The Google Push service must be configured PRIOR to sending out the                         

configuration emails. For more information see “Configure Push / Google Push” below. 
● More information about the Android Client Installation. 
● The user manual can be found here. 

 
MAC OS X 

● Mac OS 10.10 and higher. 
 
Additional Info: 

● The app itself is signed with an Apple developer account and does not require modification                             
of the security level setting for installing an untrusted application. However the installation                         
needs to be done by an administrative user. 

● Once installed and provisioned, 3CXPhone gets updated automatically with the service                     
packs of 3CX Phone System.  

● More information about the Mac Client Installation. 
● The user manual can be found here. 

 
Please see the Support Page for a list of Supported Handsets and Devices. 
 
Deploying 3CXPhone  
 
Step 1: Configure PUSH 
3CXPhone uses PUSH technology to wake up the smartphone when a call is received. This does                               
not require the user to keep the phone active and the 3CXPhone client turned on to be able to                                     
receive calls – the phone can go to sleep to save battery life. PUSH is also required for reliable                                     
operation of the smartphone clients. When extensions are created they are enabled for push                           
notifications by default. You will just need to configure Google Push Servers and open the                             
appropriate ports on your firewall for Google Push and Apple Push to function correctly.  
 
Note: Be sure to configure Google Push before sending out the welcome emails for Android users!  

Google Push 
To configure Push Servers for your Android devices, from the 3CX Management Console, select                           
“Settings” > “PUSH”, follow these instructions to configure your Google Push servers.  
 
Apple Push 
Apple Push is automatically enabled. The PBX server needs to be able to communicate with Apple                               
APN’s on certain ports. To send and receive push notifications you will need to open the ports                                 
described in the Apple push section of the Firewall Configuration guide. 
 
Step 2: Install 3CXPhone 
3CXPhone is installed via the Apple App Store for iOS devices, Google Play for Android devices, as                                 
a DMG file for Mac OS or an MSI file for Windows. The installation links are sent in the user's                                       

http://www.3cx.com/user-manual/installation-iphone/
http://www.3cx.com/user-manual/
http://www.3cx.com/user-manual/installation-android/
http://www.3cx.com/user-manual/
http://www.3cx.com/user-manual/installation-mac/
http://www.3cx.com/user-manual/
http://www.3cx.com/support/
http://www.3cx.com/docs/configuring-google-push/
http://www.3cx.com/docs/firewall-router-configuration-voip/


welcome email together with the configuration file as an attachment. For easy reference: 
 

● Windows: Download 3CXPhone for Windows as an MSI file. 
● Android: Download the Android Client from the Google Play Store. 
● iOS: Download the iOS Client from the Apple App store.  
● MAC: Download 3CXPhone for Mac as a DMG file. 

 
Step 3: Configure Using the Email Attachment 
After the user has installed the corresponding 3CXPhone version, it must be provisioned with the                             
user’s extension settings. To do this, ask the user to: 
 

1. Ensure the app or application has been installed. 
2. Open up the welcome email.  
3. Doubleclick or tap on the attachment. If you are asked what application can open this                             

attachment select 3CXPhone 14. The 3CXPhone client will then automatically configure                     
itself and connect to 3CX Phone System. 

 
The welcome email is sent automatically when the extension is created. To resend it: 

1. Log in to the 3CX Management Console and go to the “Extensions” node. 
2. Select the extension and click the “Send Welcome Email” button at the top toolbar. 
3. An email will be sent to the extension’s configured email address along with an attachment                             

for autoprovisioning. 
 
Managing 3CXPhone 
 
3CXPhone Settings 
The administrator can control what configuration options are available in 3CXPhone per extension                         
from “Extensions” node > “Edit Extension” > “3CXPhone” tab.  
 

 
 
From here you can configure:  

http://downloads.3cx.com/downloads/3CXPhoneforWindows14.msi
https://play.google.com/store/apps/details?id=com.tcx.sipphone14
https://play.google.com/store/apps/details?id=com.tcx.sipphone14
https://itunes.apple.com/us/app/3cxphone-14-for-3cx-phone/id992045982?ls=1&mt=8
http://downloads.3cx.com/downloads/3CXPhoneforMac14.dmg


● Disallow use of 3CXPhone Removes the user's ability to use 3CXPhone. 
● Hide the Forwarding Rules  Removes the user's ability to configure his/her forwarding                         

rules from within the 3CXPhone client. These options will only be available from within the                             
3CX Management Console. 

● Show Call Recordings / Allow Deletion of Recordings  Adds the management of call                           
recordings, allowing the user to manage their call recordings. 

● Configure default phone mode to use in the 3CXPhone for Windows  Configure which                           
phone mode (Softphone or CTI) must be used by default. 

● Default Startup Screen  Sets the default appearance of the phone to the dial pad or the                                 
presence screen. 

● Use 3CX Tunnel for remote connections  Configures 3CXPhone to use the 3CX Tunnel                           
for the “Out of Office” connection to 3CX Phone System rather than connecting directly via                             
STUN/SIP port of the pbx.  

 
3CXPhone for Windows, Mac, iOS and Android have the ability to reprovision automatically. By                           
default, Windows, Mac and Android clients will retrieve their configuration file every time they are                             
started. This means that any setting you make in the management console will be applied at the                                 
next startup of the client. 
 
Phones node 
The administrator can review all connected users that are using 3CXPhone from the 3CX                           
Management Consoles’ “Phones” node. This shows all the users who are currently logged in and                             
using 3CXPhone, including their IP and the client version/type they use. If the extension is not listed                                 
in the 3CXPhone Clients tab, the client is not currently connected.  
 
Updating 3CXPhone for Windows and Mac 
Updates to 3CXPhone for Windows and Mac are deployed automatically via the 3CX Phone System                             
Server. When a new update is available on the 3CX Website, the 3CX Phone System Server                               
downloads the update for 3CXPhone then notifies the users. If a user has an outdated 3CXPhone,                               
upon starting it they will be shown a message informing them that a new version is available: 
 



 
 

Once the user accepts the update, the downloader will start and download the new installation of                               
3CXPhone. After the file has finished downloading, the new client will be installed automatically and                             
3CXPhone will restart on its own to complete  
 
Updating 3CXPhone for iOS and Android 
The Android and iOS clients update automatically through the Google Play store and the Apple App 
Store (depending on whether automatic update is activated) when they detect a newer version of 
the client online.  
 
See Also 

● Find out what IP phone CTI mode is. 
● Learn how to configure Google Push here. 
● See instruction on installing 3CX Phone for Windows, Android, iOS, Mac 

 
 
 
 
 

http://www.3cx.com/user-manual/cti/
http://www.3cx.com/docs/configuring-google-push/
http://www.3cx.com/user-manual/installation-windows/
http://www.3cx.com/user-manual/installation-android/
http://www.3cx.com/user-manual/installation-iphone/
http://www.3cx.com/user-manual/installation-mac/
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Introduction 
Once 3CX Phone System is installed, you can configure your IP phones and assign an extension to                                 
each phone. In order to do this, you must provision the IP phones. Although phones can be                                 
configured one by one manually using their web interface, this is impractical as it leads to many                                 
errors and deployment time is increased drastically. Furthermore, ongoing management of the IP                         
phones is almost impossible. Supported IP phones can be provisioned automatically, providing ease                         
of deployment AND ongoing management. 
 
Phone Provisioning 
 
What is Phone Provisioning? 
Phone provisioning is the process of automatically configuring the IP phone for use with an IP PBX.                                 
Once you provision a phone, the phone will automatically configure itself correctly and you will be                               
able to manage the phones centrally and remotely and without having to login to the phones’ web                                 
interface one by one. Phone provisioning greatly eases day to day management of IP phones. It                               
makes it easy to change extension passwords, BLF lights and so on because you can do it centrally                                   
for all phones from the 3CX Management Console and then push the changes to the phone. 
 
How does Phone Provisioning work? 
The process of provisioning a phone with 3CX Phone System is easy: 

1. To provision a phone, you will need to ensure it can retrieve its configuration from 3CX                               
Phone System using the Provisioning URL. The provisioning URL is a resolvable FQDN with                           
a customized parameter at the end, unique to your 3CX Phone System installation for                           
security purposes.  

2. The provisioning URL can be entered into the phone in any of the following 3 ways: 
● Automatically using Plug n Play, 



● OR Using DHCP option 66, 
● OR by entering it in the phones web interface. 

3. After you do this, the phone will automatically restart. 
4. The phone will retrieve the configuration settings and will be completely manageable from                         

within the 3CX Management Console. 
 
Spend the extra half an hour to provision the phones and save countless hours going forward! 
 
Provisioning using Plug and Play 

 
In this method: 

1. Plug the phone into the network.  
2. The phone will send a multicast message across the LAN. 
3. This will be picked up by 3CX Phone System providing it is on the same LAN. 
4. The phone will appear in the “Phones” page. Now you can assign an existing extension to                               

the phone or create a new extension. 
5. The phone will be sent a provisioning URL. 
6. The IP phone will restart and be manageable from within the 3CX Management Console. 

 
Requirements: For this method the requirements are that the IP phone must be a preferred phone,                               
as the IP phone vendor must have implemented the Plug and Play functionality. For a list of                                 
preferred phones refer to our Supported Phones page. Also, the IP phone must be located on the                                 
same LAN as a multicast message will not traverse firewalls. 

http://www.3cx.com/sip-phones/


Provisioning the URL via Option DHCP 66 

 
In this method: 

1. Note down the MAC address of the phone. This is usually written on the back of the phone.                                   
You can also use a bar code scanner to read it from the label. 

2. Create or edit an extension and enter this MAC address into the “Extensions” > “Phone                             
Provisioning” tab. 

3. Obtain the provisioning URL for 3CX Phone System. It is displayed in the Quick Start page,                               
and in the “Settings” > “Phone Provisioning” page. It consists of the FQDN of your 3CX                               
Phone System machine and an additional string for security purposes. Click on the link to                             
make sure it resolves! 

4. Now configure the provisioning URL in your DHCP server using option 66. See an example                             
how to do this for the Microsoft Windows DHCP Server 

5. The phone will now retrieve the URL from the DHCP server at startup. 
 
For larger numbers of phones this is the recommended method as changes to FQDN or webserver                               
ports can be done at DHCP level and all phones can take the new configuration after reboot.  
 

http://www.3cx.com/sip-phones/dhcp-option-66/
http://www.3cx.com/sip-phones/dhcp-option-66/


Provisioning the Phone by Entering the URL in the Web Interface 

 
 
In this method: 

1. Note down the MAC address of the phone. This is usually written on the back of the phone.                                   
You can also use a bar code scanner to read it from the label. 

2. Create or edit an extension and enter this MAC address into the Phone Provisioning tab. 
3. Obtain the provisioning URL for your 3CX Phone System. It is displayed in the Quick start                               

page, and in the “Extension” > “Phone Provisioning” page. It consists of the FQDN of                             
your 3CX Phone System machine and an additional string for security purposes. Click on the                             
link to make sure it resolves. 

4. Now login to the phone’s Web Interface and enter the provisioning URL. This is a onetime                               
operation provided your FQDN or HTTPS port does not change.  

 
This method is recommended for a smaller number of phones, for remote networks, and if your                               
DHCP server does not support option 66. 
 
Provisioning Fanvil, Htek, snom and Yealink IP Phones using Plug and Play 

 
 
To auto provision phones using Plug and Play: 

1. Connect the IP phone to the LAN. Ensure that the phone is on the same LAN (Multicast                                 
Domain) as 3CX Phone System. 

2. The phone will show up in the “Phones” node in the 3CX Management Console as a new                                 
phone. 

3. Rightclick on the phone’s entry and assign it to an existing extension or create a new one. 
4. You will then be taken to the extension’s provisioning tab where you can specify other                             

configuration settings on the phone.  
5. The phone will be sent a link to the configuration file with the settings you specified. The                                 

phone will then restart, apply the settings and connect to 3CX Phone System. Some phones                             
will ask for confirmation before restarting. 



Provisioning Cisco, Polycom & Remote Phones ( DHCP & Manual) 
Cisco and Polycom phones do not support plug and play and must be provisioned as described                               
below. Remote phones can not be configured via Plug and Play as they will not receive the                                 
multicast message. In this case you must also use the method below. 
 
Step 1 – Enter the IP Phone MAC Address 

 
 

1. From the “Extensions” node in the 3CX Management Console, select the extension you                         
want to provision, click “Edit Extension” > then switch to the “Phone Provisioning” tab. 

2. Enter the MAC address of the phone (which can be found at the bottom of the phone) in the                                     
MAC address field. 

3. Select the appropriate phone model from the drop down menu of the Model list. 
4. Phone Web Page Password – This is auto generated by 3CX Phone System and is applied                               

to your phone upon provisioning. If you want to log into your IP phone’s Web Interface then                                 
use the value in the “Password field” on the Web Interface login screen (Username is not                               
changed in the Phone’s Web Interface, it remains as its default value admin even after                             
provisioning). You may leave the Web Page Password as is or specify your own. 

5. Confirm the IP address which the phone should connect to (in case your phone system                             
server has multiple network interfaces). 

6. In the “Select Provisioning Method” dropdown menu, select the appropriate provisioning                     
method for the location of the phones. For phones located on the LAN, select “Local Lan (In                                 



the Office)”. If this is a remote phone, select either “Remote Extension (STUN)” or 3CX                             
Session Border Controller depending on whether you are using the 3CX SBC or not.                           
Learn more here. 

7. The codecs and codec priority will be automatically configured depending on the phone                         
model selected. 

8. If your phone has BLF lights, you can automatically configure what information the BLF lights                             
should display. Match a BLF button with an extension, so that this button will show the status                                 
of that extension. The number of available BLF buttons varies per phone. 

9. You can also link a shared parking place to a BLF button. This allows users to easily park or                                     
unpark calls by pressing the assigned BLF button. Speed dials and custom speed dials are                             
also supported. 

10. Click “OK” to save. The provisioning files will now be created in the provisioning directory.                             
Each time you make a change to the extension, these files will be recreated. 

 
Step 2 – Configure the Phone to Retrieve the Configuration File 
Now you need to instruct the phone to download its configuration from the provisioning directory on                               
the 3CX Phone System server: 
 

1. Determine how to enter the Phone Provisioning URL in your phone. In some cases the URL                               
must be modified somewhat. Follow the IP phone configuration guides in the Supported IP                           
Phones page. 

2. Decide whether you will use option 66 and DHCP or whether you will configure the URL                               
manually via the phones web interface. 

3. If using Option 66 in your DHCP Server, configure your DHCP server to provide the                             
provisioning URL at startup. More information follow our guide on How to AutoProvision IP                           
Phones with the DHCP “Option 66” 

4. If via the Phone’s Web Interface, follow the steps in the configuration guide for your phone. 
 
Managing Your IP Phones 
3CX Phone System provides an easy way to monitor and manage your phones throughout your 
network. The “Phones” node in the 3CX Management Console allows you to: 
 

● View all phones in the network. 
● Quickly view the IP and Mac address of each phone. 
● Check the firmware version that the phone is running. 
● Remotely reboot one or all of the phones. 
● Reprovision the phones (after you have made a change you can reboot the phones as 

changes take effect immediately). 
● Launch the admin interface of the phone. 
● Monitor security of extension password and PIN. Weak extension passwords and PINs 

are the most common cause of security breaches. 
 
Changing Settings and ReProvisioning the Phones 
Changes made to the phone configuration from the “General” tab of the “Extensions” node or                             
within the “Phone Provisioning” section of the “Settings” node, will take effect within 24 hours.                             
You can reprovision the phones to force them to pick up the new configuration immediately.  
 
If you need to reprovision the phones, for example after you have made configuration changes: 

http://www.3cx.com/docs/3cx-tunnel-session-border-controller/
http://www.3cx.com/sip-phones
http://www.3cx.com/sip-phones
http://www.3cx.com/sip-phones/dhcp-option-66/
http://www.3cx.com/sip-phones/dhcp-option-66/
http://www.3cx.com/sip-phones/dhcp-option-66/


1. Select the “Phones” node in the 3CX Management Console. 
2. Select the phones that you wish to reprovision. 
3. Click “Reprovision phones”. 
4. Select the phones again and select “Reboot” to restart the phones and activate the new 

provisioning information. 
 
Updating the Firmware on Your Phones 
It is possible to update the firmware of your Cisco, Fanvil, Htek, snom, and Yealink IP phones                                 
throughout your network from the 3CX Management Console. Each of the firmwares has been                           
interop tested by 3CX. It is recommended that you upgrade firmware using this method and not by                                 
downloading the firmware directly from the vendor’s websites. To upgrade your IP phones to the                             
latest 3CX tested firmware: 
 

 
 

1. From the “Phones” node, select the IP phones which you wish to upgrade the firmware on                               
and click the “Upgrade Firmware” button. 

2. Select the model and firmware of the phone from the upgrade list and click “Upgrade”. The                               
firmware will be uploaded and the phone rebooted. Note this feature requires a valid                           
maintenance agreement. 

 
Remote Extensions 
A powerful benefit of 3CX Phone System is its ability to support remote extensions, i.e. employees                               
using their extension from home or on the go. This gives tremendous flexibility to employees and                               
delivers true mobility, because employees working from home or away can still be seamlessly                           
integrated with the head office phone system. They can be members of call queues and use                               
3CXPhone to see the presence of other users. There are two ways to configure a remote extension: 
 

● Directly using standard UDP. Requires correct Firewall & Router Configuration and might be                         
problematic with some low end firewalls. 

● Using the 3CX Tunnel protocol. Requires deployment of the 3CX SBC (Session Border                         
Controller). Read our guide about the 3CX Tunnel / 3CX Session Border Controller 

 
Deploying the 3CX SBC is preferable. See our guide on Provisioning a Remote Extension for a                               

http://www.3cx.com/docs/firewall-router-configuration-voip/
http://www.3cx.com/docs/3cx-tunnel-session-border-controller/
http://www.3cx.com/blog/docs/provisioning-a-remote-extension/


more detailed explanation of the subject. 
 
See Also 

● Have more than one phone? No problem see Configuring Multiple IP Phones for a Single                             
Extension.  

● In addition to IP phones, 3CX supports various for endpoints See Supported IP Phones                           
Page for the full range. 

● Remote phones? Read our guide on Provisioning a Remote Extension 
● For Information on Port forwarding see our guide for your Firewall & Router Configuration. 
● How to configure Yealink Hot Desking with 3CX Phone System and use the same IP phone                               

for multiple users.  
● How to configure snom Hot Desking with 3CX Phone System. 

http://www.3cx.com/docs/configure-multiple-ip-phones/
http://www.3cx.com/docs/configure-multiple-ip-phones/
http://www.3cx.com/sip-phones
http://www.3cx.com/sip-phones
http://www.3cx.com/blog/docs/provisioning-a-remote-extension/
http://www.3cx.com/docs/firewall-router-configuration-voip/
http://www.3cx.com/docs/yealink-hot-desking/
http://www.3cx.com/docs/snom-hot-desking/
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Introduction 
This chapter explains how to create and configure extensions in 3CX Phone System. There are                             
multiple ways to create an extension: 
 

● When provisioning a new phone, you can choose to create a new extension. 
● Extensions can be manually created from the “Extensions” node. 
● Extensions can be imported from Active Directory (or any other LDAP server). 
● Extensions can be imported from a .csv file including parameters such as DID. 

 
Importing Extensions from Active Directory 
You can import extensions directly from Active Directory or another LDAP server. The added benefit                             
to this method is that every time a change is made to the user configuration in Active Directory,                                   
users can be resynchronised, in which case only the updates will be imported. The step by step                                 
guide on how to Import Extensions via 3CX Active Directory explains the process in detail.  
 
 
 

http://www.3cx.com/blog/docs/import-active-directory/


Importing Extensions from a .csv FiIe 
Create a spreadsheet with columns for each field that you wish to import and save as a .csv file. 
The document How to Manage Extensions in Bulk using a .csv file has a detailed explanation on 
how to achieve this. Then: 
 

1. Log in to the 3CX Management Console and click on the “Extensions” node. 
2. Click on the “Import extension” button. 
3. Select your .csv file and click “Open” to import your extensions. 

 
Extension Configuration 

 
To configure an extension, click on the “Extensions” node in the 3CX Management Console. Click                             
on “Add Extension” to create a new one or select an existing extension and click “Edit                               
Extension”. 
 
General 
In the User Information section you can enter the first name, last name and the email address of the                                     
user. A welcome email with information on the extension created, as well as voicemail and missed                               
call notifications (configurable), will be sent to the specified email address. In the Authentication                           
section, the authentication ID and password are auto generated, however they can be altered as                             
needed. If the phone is provisioned, the authentication details will be sent to the phone                             
automatically. 
 

http://www.3cx.com/blog/docs/bulk-extension-import/


Voice Mail 

 
 

The “Voice Mail” tab allows you to configure the extension’s voice mail preferences including the                             
voicemail PIN number for authentication, enable/disable PIN Authentication, play Caller ID, and if                         
you want 3CX Phone System to read out the Caller ID and the Date / Time of when the message                                       
was received. You can also choose to send an email notification, when voicemail is received. This                               
can be configured to contain the voicemail message, and also delete the message from the server                               
freeing up space.  
 
The “Manage greetings” section allows you to configure your voicemail greetings. The following                         
options are available: 

● Add new – Allows you to add a new greeting from a prerecorded .wav file. 
● Record from phone – Lets you record a new greeting file from your phone and add it to the                                     

greetings list on the left. 
● Delete – Deletes the selected greeting file from the greeting list on the left. 
● Refresh WAV files – Refreshes the list of greeting files in the user’s folder. 
● Play on phone – Allows playback of the selected greeting file on a configured IP phone. 
● Play  Allows you to download the selected greeting  file to your computer and listen to it. 
● You can also choose whether to play the same greeting file for all your statuses or configure                                 

different greeting messages for each status. 
 
 



Forwarding Rules 
Each extension can have a set of call forwarding rules that define what 3CX Phone System should                                 
do when the extension user is unable to take an incoming call. This can be configured based on: 

● The user’s status.  
● The time.  
● The caller ID. 
● Whether the call is an internal or external call. 

 
Each status requires a call forwarding rule. For example, if the user is unable to take a call whilst                                     
their status is “Available”, you can forward the call to voicemail, whilst if the status is set to “Out of                                       
Office” you could forward it to their mobile. 
 
Call forwarding can be configured by the administrator using the 3CX Management Console or by                             
the user from the 3CXPhone client. Instructions on how to configure call forwarding for an extension                               
can be found on the Configuring Forwarding Rules user manual page. 
 
Other 
User Information 
The user information section allows you to set status, log in and out of queues, turn DND on or off,                                       
configure the caller ID for the extension and the SIP ID. 
 
Extension Capabilities 
The extension capabilities section allows you to set advanced options for a particular IP phone                             
registered to this extension. These options are best left as default. 
 
Options 
The options tab allows you to configure options, restrictions and access for the extension. 
 

 
 

http://www.3cx.com/user-manual/forwarding/


● Record all calls – Records all calls for this extension. 
● Call screening on – Use ONLY for the Rebound feature. Will prompt the user for a name                                 

and play the name to the called party so that the person may decide to take the call or not. 
● Send email notification for missed calls – Triggers an email for each missed call. 
● Do not show extension in 3CX company phonebook – Removes extension from the 

phonebook. 
 
Restrictions 

● Disable Extension – Disables extension. 
● Disable External Calls – Disallows any external calls from the extension. 
● Pin Protect  You can configure an extension to allow outbound calls only after they enter a                                 

PIN. To unlock the extension, the user dials 777 followed by the PIN and a #. The PBX will                                     
inform the user that access has been granted. The user can then proceed to dial the desired                                 
external number. 

● Disallow use of extension outside the LAN – Blocks any registrations from outside of the                             
network. This setting applies to IP phones. 

● Block remote tunnel connections – Blocks the extension from being registered outside of                         
the network, even if it uses the tunnel feature (which is seen as a local registration). 

 
Access 
This section allows you to control access to the 3CX Management Console, 3CX Web Reports and                               
3CX Hotel Module to an extension. 
 
Office Hours Scheduling 
The Office Hours Scheduling feature allows a user’s status to be changed based on global office                               
hours or specific office hours. 
 

 
 
Configure Hours 
Select if the extension will follow the PBX’s Global Office Hours, or use its own Specific Office                                 
Hours. To specify Specific Office Hours, enable the option and click “Configure”. You can also                             
configure Break Times by clicking “Configure” next to the option. These options can be used in                               
conjunction with the options available below to automatically change the status of the extension. 



Automatic Extension Scheduling 
When you have Configured Office hours and Break times, you can enable the following options to 
control automatic status changes and extension functionality based on the time of day: 

● Automatically change extension profile based on time of day – Outside of Office hours,                           
the user’s status will automatically be switched to “Out Of Office”. The user’s status can                             
also be changed to “Away” on configured break times. 

● Log out from queues when not available (Away / Out of Office) – This option will                               
automatically log the user out from queues when he switches to “Out of Office” or “Away”                               
status. 

● Block Outbound calls outside of Office Hours – Blocks any outbound calls from this                           
extension outside of office hours. 

 
Extension Rights 

 
 
The “Rights” tab allows you to quickly check an extension’s Group membership rights for this                             
extension and configure them according to your preferences. All the available groups appear on the                             
“Group Membership” list on your left. 
 
Any group that the extension already belongs to, is checked, and the role of the current extension in                                   
the group appears in the Role column. The user’s rights for the selected group are displayed on the                                   
right side of the tab. 
 
You can modify the extension’s rights for that group by ticking off the options in the “Rights                                 
currently assigned” section of the tab or even change the extension’s role by clicking on the “User                                 
Rights” and selecting “User” or “Manager” from the drop down menu. 
 
To add an extension to a group simply tick the checkbox next to the group name that you want the                                       
extension to be a part of and select the user rights on the “User Rights” section of the tab. Click                                       
“OK” to apply your changes. 



Extension Groups 
Extension groups are used to determine what information is shown to whom. In addition, they help                               
group the extension for both users and administrators. Note that an extension has to be part of at                                   
least one group. 
 
Users can be assigned rights to see details of other members in their group, managers can be                                 
assigned elevated rights over users in their group. Rights are assigned based on Group                           
membership. That means that a manager will be able to see call details of any member of their                                   
group, independent of the call destination or origin. 
 
Default Group 
The Default group contains all extensions, whereby users of the group have no rights, but managers                               
of this group can see information about all the extensions. Any extension you create will                             
automatically be assigned to this group initially (until you remove it or assign it to another group). 
 
Note: The V11 management group has now been rendered obsolete and is replaced by the                             
‘Default’ group. “Management Group rights” is now “Default Group Rights” in the Default                         
Group. If you are restoring a backup from V11 then all the users will be added as users to the                                       
Default group and any managers in the management group will be added as managers in the                               
Default group. 
 
The Default Group is a group that is always present in 3CX Phone System. Managers assigned to                                 
this group can: 

● See the call details of ALL extensions and queues (since all extensions are part of the                               
default group unless you remove them from the group) 

● Perform operations on ANY call in the system (Pickup, Transfer, Divert, Reject, Bargein,                         
and Park). 

 
To add an extension to the Default group: 

1. Click on the “Default” subnode under the “Extensions” node. 
2. Select an extension on the left and click “Add”. Click “OK” to save changes. 
3. Now logout and login with this extension’s 3CXPhone to see the additional information. 

 
Group Membership 

 
 



To create an extension group: 
1. In the 3CX Management Console, click on the “Extensions” node and click on the “Add                             

Extension Group” tab, from the top menu. 
2. Now proceed to add extensions by selecting extensions from the left list and clicking on the                               

“Add” button. Note that Extensions can now be part of multiple groups. Publish Group                           
information to all company users: This option publishes your Group presence to all the                           
3CX Phone System Users (all the extensions can see your group presence and calls). 

 

 
 
You can select which user will be the Manager of the group by: 

1. Clicking on the “Member Rights” tab, then clicking on the user’s name in the “Extensions                             
in this Group” list. 

2. You may then select the “Role of user in this group” where you may select “Manager” or                                 
“User” and accordingly the user will be granted the rights of a manager or a user. You can                                   
configure one or more “Managers” for any group. Typically this would be a department                           
supervisor. Group Managers will be able to see the call details of everyone within that group. 

 
Group Default Rights 
The “Default Group Rights” tab specifies the default rights that are assigned to each user role.                               
The default “Manager” and “User” rights apply to the current extension group. You can configure                             
these rights separately for each extension group.  
 
To configure the default group rights: 

1. Click on the “Default Group Rights” tab. These settings pertain to what group members                           
and users within this group can see and do in 3CXPhone. 

2. Optionally you can enable the Manager's extension to perform operations on calls of the                           
group members. Check the option “Perform operations on calls to users of this group”                           
to enable this. 

3. Similarly, you can also configure what rights User group members have. 
4. Click “OK” to save the group and rights information. Users will need to logout and login to                                 

3CXPhone to see their new rights reflected. 



Customizing Rights for Individual Users 

 
  

If you want a particular user or manager to have more (or fewer) rights than the defaults specified in                                     
the “Default Group Rights” tab, you may specify these rights by: 

1. Clicking on the member’s name in the “Extensions in this Group” list in the “Members                             
Rights” tab. 

2. Ticking off the checkboxes with the rights that you want the member to have in the “Rights                                 
currently assigned” part of the tab. 

3. The options available for the users are: 
● Can see group members – Allows the user to see all group members presence. 
● Can see group calls – Allows the user to see calls made by group members. 
● Show presence to group members – Shows the user’s presence to group members. 
● Show calls to group members – Shows user’s calls to group members. 
● Perform operations (divert, transfer, take) on any active call to group members. 
● Can Barge in – Can barge in to calls made by group members. 
● Can Intercom – Allows the user to intercom other extensions. 
● Allow parking – Allows the user to park calls so that other users can pick them up. 
● Allow IVR control – Allows user to control the IVR. 
● Allows to manage Company Phonebook – Allows the user to add / edit / Delete                             

contacts from the Company Phonebook via the 3CXPhone for Windows Client. 
4. Select the options that suit your needs accordingly and then click “Apply” to apply the                             

chosen rights. A restart of the configured extensions 3CXPhone client is needed for the                           
changes to take effect. 

 
Regenerate Provisioning Files 
When you make a change, for example, to ports or the FQDN then the provisioning URLs will                                 
change. In this case you will need to reprovision your phones so they obtain the new URL. This can                                     
be done directly from the 3CX Management Console. 
 

 



To regenerate provisioning files:  
1. From the “Extensions” node in the 3CX Management Console select the extensions which                         

you would like to regenerate the provisioning file for, select a single extension or hold down                               
the “CTRL” key on your keyboard to choose more than one extension. 

2. From the top menu click “Regenerate provisioning files”. The provisioning files will then                         
be regenerated for the extensions chosen. You can then reprovision the phones to pick up                             
their regenerated provisioning files as described in the Changing Settings and                     
ReProvisioning the Phones section in the previous chapter.  

 
Recordings 
Conversation recordings and voicemail messages can grow quite large and take up a lot of space.                               
You can manage these recordings by setting Auto Clearing Options to limit them. You can also                               
download and delete recorded conversations directly from the “Recordings” node in the 3CX                         
Management Console.  
 

 
 
To set up the number of days to keep recordings: 

1. Expand the “Recordings” node and click on the “Quota” button. 
2. Tick the checkbox for the type of recordings to clear, then select the number of days that                                 

they will be kept before they’re deleted and click “Save”. 
 
See Also 

● Information on delegating 3CX Management Console access, along with use case examples                       
read our Delegating 3CX Management Console Access chapter. 

● See the user manuall about Recording a conversation or conference call. 
● See our Checking and Managing your Voicemail guide to learn how to do this from your 

3CXPhone. 
● Find information on Customizing Email Templates.  
● Read more about Recording Management. 

 

http://www.3cx.com/docs/managing-ip-phones-endpoints/#h.dgpfsrmujqpl
http://www.3cx.com/docs/managing-ip-phones-endpoints/#h.dgpfsrmujqpl
http://www.3cx.com/docs/3cx-management-console-access/
http://www.3cx.com/user-manual/recording/
http://www.3cx.com/user-manual/voicemail/
http://www.3cx.com/blog/docs/customizing-email-templates/
http://www.3cx.com/blog/docs/manage-recordings/


Configuring a VoIP Provider / SIP Trunk 
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Introduction 

Requirements for using a VoIP Provider / SIP Trunk 
Configuring a VoIP Provider / SIP Trunk 

Step 1: Create an Account with a VoIP Provider 
Step 2: Add the VoIP Provider Account in 3CX Phone System 

DID’s and Inbound Call Identification 
See Also 

 
Introduction 
VoIP providers “host” phone lines and replace the traditional telco lines. VoIP providers can assign                             
local numbers in one or more cities or countries and route these to your phone system. In most                                   
cases they also support number porting.  
 
VoIP providers are often able to offer better call rates because they may have an international                               
network or have negotiated better rates. Therefore, using VoIP providers can reduce call costs.                           
However, be aware that each VoIP call requires bandwidth. VoIP is real time, so it does place a                                   
demand on your Internet connection. As a rule of thumb, each call will consume approximately                             
30120 kb per second, depending on which codec you use. The document, Bandwidth Overhead                           
over DSL connections, includes detailed information about bandwidth consumption, including                   
particular codecs bandwidth usage. 
 
3CX recommends using supported VoIP providers. All supported VoIP providers have been tested                         
for interoperability with 3CX Phone System, and are retested with each new build. Their                           
configuration templates are also included with 3CX Phone System to allow you to quickly and easily                               
add them. See the list of 3CX Supported SIP Trunk Providers. 
 
3CX Phone System supports two types of VoIP providers: 

● Registration Based – These VoIP providers require the PBX to register with the provider                           
using an authentication ID and password. Most of the VoIP providers predefined in 3CX                           
Phone System are registration based. 

● IP Based / SIP Trunk – IP Based VoIP Providers (also known as SIP Trunks) do not                                 
generally require the PBX to register with the provider. The IP address of the PBX needs to                                 
be configured with the provider, so that it knows where calls to your number should be                               
routed. 

 
Requirements for using a VoIP Provider / SIP Trunk 
If you plan to use a VoIP provider, you need to have a firewall/router/NAT device that supports                                 
STATIC PORT MAPPINGS. Often routers will perform port address translation, which will cause                         
problems such as one way audio, failing inbound calls and so on. It is also highly recommended that                                   
you have an FQDN that resolves to a static external IP. If your external IP changes intermittently,                                 
inbound calls will fail. See the Firewall & Router Configuration for details to configure your                             
firewall/router/NAT device. 
 

http://www.3cx.com/blog/docs/bandwidth-dsl-atm-isp/
http://www.3cx.com/blog/docs/bandwidth-dsl-atm-isp/
http://www.3cx.com/partners/sip-trunks/
http://www.3cx.com/docs/firewall-router-configuration-voip/


Configuring a VoIP Provider / SIP Trunk 
 
Step 1: Create an Account with a VoIP Provider 
First, you need to have an account with a VoIP service provider. 3CX Phone System supports most                                 
popular SIP based VoIP service providers and we recommend using one that has been tested by                               
3CX as 3CX includes preconfigured templates for these VoIP providers. Go to                       
http://www.3cx.com/partners/voipproviders/ to see a list of supported providers. 
 
Step 2: Add the VoIP Provider Account in 3CX Phone System 
After you have created the VoIP provider account, you will need to configure the account in 3CX                                 
Phone System. To do this: 
 

1. In the 3CX Phone Management Console menu, select “SIP Trunks” > “Add Provider” 
 

 
 

2. 3CX Phone System will prompt you to conduct a Firewall Test. Frequently, the internet                           
facing firewall sitting between 3CX Phone System and the VoIP provider is not correctly                           
configured or is not able to correctly route VoIP traffic. To check the firewall configuration, it                               
is important to perform a firewall check using the inbuilt firewall checker. 

 
● Click “Run Firewall Checker”.  
● Ensure that the tests for the SIP Port (default port 5060), and the Audio Port range                               

(default ports 90009255) all pass with success. If the firewall check fails, you must                           
go to your firewall and troubleshoot why the test failed. 

● After successfully completing the test, return to the VoIP Provider Wizard.  
 

Note: 3CX does not provide specific firewall configuration support. 
 

http://www.3cx.com/partners/voip-providers/
http://www.3cx.com/blog/docs/firewall-checker


 
 

3. Enter a friendly name for this VoIP provider account. 
4. Select the Country that the VoIP provider operates in. 
5. Select your VoIP provider from the Provider drop down list. If the provider is not listed, select                                 

“Generic VoIP Provider”, or “Generic SIP Trunk”, (If using a generic provider we will not be                               
able to guarantee that 3CX will work with this VoIP provider), Click “Next”. 

6. The SIP server hostname or IP may be prefilled. Compare these with the details that you                               
have received from your VoIP provider and check that these are indeed correct. Depending                           
on the VoIP provider that you are using, some fields will be disabled. This means you do not                                   
need to change them. Click “Next” to continue. 

7. Now enter the VoIP provider account details. In the External number field, enter the VoIP                             
line number that has been assigned to you. Then enter the Authentication ID/username and                           
password of your VoIP provider account. Specify the number of simultaneous calls your                         
provider allows. Click “Next” to continue. If you are using a SIP trunk, the password will be                                 
greyed out, since authentication is done via IP. 

8. Specify how calls from this VoIP provider should be routed. You can specify a different route                               
outside office hours. The routing configured here will take effect when no inbound routing                           
rules are matched. 

9. On the next page, you can optionally configure an outbound call rule, which will be used to                                 
route outbound calls through the new provider. This is normally done by routing calls starting                             
with a specific prefix. Enter the dialling prefix in the “Calls to numbers starting with                             
(prefix)” text box. To make calls via this provider, precede the number to be dialled with this                                 
prefix. 

 
More about Outbound and Inbound Rules can be found in the Trunk Management Section. 
 
 
 
 
 
 
 
 
 
 

http://www.3cx.com/docs/trunk-management/


DID’s and Inbound Call Identification 
If your VoIP provider has provided you with DID numbers, you will need to specify these in the DID                                     
tab. To do this: 

 
 

1. In the 3CX Management Console, select “SIP Trunks” click on the VoIP provider you want                             
to configure. 

2. Click on the “DID” tab. 
3. Add the DID numbers associated with your account. An Inbound Rule, which can be                           

configured at a later stage, will be created for each number specified in this list. 
 
You can also see the list of inbound rules by expanding the “Inbound Rules” node.  
More about Inbound Rules can be found in Chapter 8. 
 
See Also 

● See the Firewall & Router Configuration to configure your firewall/router/NAT device. 
● Find more about Outbound and Inbound Rules in the Trunk Management Section. 
● Add How much dedicated bandwidth do I need for VoIP? See the Bandwidth Overhead over 

DSL connections guide to find out. 
● See the list of 3CX Supported SIP Trunk Providers. 

 

http://www.3cx.com/docs/firewall-router-configuration-voip/
http://www.3cx.com/docs/trunk-management/
http://www.3cx.com/blog/docs/bandwidth-dsl-atm-isp/
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Configuring VoIP Gateways 
 
On this topic 

Configuring VoIP Gateways 
Introduction 

What is a VoIP Gateway? 
What is a Port? 
Supported VoIP Gateways 
Step 1: Discover and Update the VoIP Gateway 
BeroNet Gateways 
Patton SmartNode Gateways 
Welltech WellGate Gateways 
Step 2: Configure the VoIP Gateway in 3CX Phone System 

See Also 
 
Introduction 
External calls can be made on PSTN/phone lines or via VoIP providers. A traditional PBX requires                               
you to connect the PSTN lines to the PBX hardware box; however in the case of 3CX Phone                                   
System you have more options: 
 

● Connect PSTN lines (physical phone lines) to a VoIP Gateway situated on your internal                           
network. 

● Connect PSTN lines to a VoIP addin card, installed on the machine running 3CX Phone                             
System or on another machine. 

● Use a “hosted” phone line from a VoIP Service Provider. In this case the VoIP service                               
provider gives you the ability to make calls via your internet connection. This is explained in                               
the next chapter. 

 
To make and receive external phone calls via your regular phone lines, you will have to buy and                                   
configure a VoIP gateway. This chapter explains what they are and how to configure them. 
 
What is a VoIP Gateway? 
A VoIP gateway is a device which converts telephony traffic into data, so that it can be transmitted                                   
over a computer network. In this manner PSTN/telephone lines are “converted” to SIP extensions,                           
allowing you to receive and place calls via the regular telephony network. VoIP Gateways exist for                               
analog lines as well as BRI, PRI/E1 lines and T1 lines. VoIP cards do the same thing, but are addin                                       
cards that are installed into a computer. 
 
What is a Port? 
A port is a physical line outlet on a gateway or VoIP card. In the case of an analog line, one port is                                             
used for each voice channel. In the case of BRI ISDN, one port allows for two voice channels, and                                     
in the case of E1 or T1 ports, each port represents 30 and 23 channels respectively. Just as it is                                       
necessary to configure a phone to register with the phone system, it is also necessary to configure                                 
the VoIP gateway or card to register its ports with 3CX Phone System. Some devices build a hunt                                   
group for all available ports and present them as on single virtual extension inside 3CX Phone                               
System (Beronet & Patton devices) and others represent each port individually (Welltech). 
 



Supported VoIP Gateways 
It is important to use a VoIP gateway supported by 3CX. Supported gateways have been tested by                                 
3CX and are automatically configured with their correct settings. If using the default configuration,                           
3CX will also provide first line support of their use with 3CX Phone System. A list of the latest                                     
supported gateway hardware, can be found on the Supported VoIP Gateways & ATA's page. 
 
In order to configure a VoIP Gateway with 3CX follow the steps outlined below. 
 
Step 1: Discover and Update the VoIP Gateway 
The first step is to connect the gateway, assign a static IP and update the firmware on the VoIP                                     
Gateway. 
 
BeroNet Gateways 
If you have a BeroNet gateway, you will need to: 
 

1. Use the “bfdetect” tool to find the gateway on the network. 
2. Configure the Gateway in 3CX as described in the next step. 
3. Click on the "Configure BeroNet Card" button at the bottom of the summary page 
4. Login with admin/admin and follow the screen instructions to complete the setup. 

 
More information is about Configuring Beronet BeroFIX.  
 
Patton SmartNode Gateways 
If you are using a Patton SmartNode gateway, you will need to: 
 

1. Use the Patton SmartNode Discovery Tool to find the gateway on the network. 
2. Configure the Gateway in 3CX as described in the next step. 

 
More information about Connecting A SmartNode to the Network. 
 
Welltech WellGate Gateways 
If you want to use a Welltech gateway, you will need to: 
 

1. Plug an analog phone into the device and dial #126# on FXS devices 
2. Prepare the Welltech Gateway by updating the required firmware provided by 3CX. 
3. Update 3CX Phone System to download the latest template updates for your Wellgate. 
4. Configure the Gateway in 3CX as described in the next step. 

 
Step 2: Configure the VoIP Gateway in 3CX Phone System 
The second step is to create the VoIP gateway in the 3CX Management Console and configure it. 
 

http://www.3cx.com/voip-gateways/
http://www.3cx.com/support/
http://www.3cx.com/voip-gateways/beronet-berofix-400
http://www.3cx.com/blog/voip-howto/patton-smartnode-configuration/
http://www.3cx.com/voip-gateways/


 
1. In the 3CX Management Console, click the “PSTN Gateways” node > “Add Gateway”. 
2. In the name field, enter a friendly name for the VoIP gateway. Now choose the gateway                               

brand and model that you are using from the list. Click “Next”. 
3. Depending on the gateway you selected, you might be asked additional options, such as                           

what country the device will be connected in. Some options are line specific and you may                               
need to check with your line provider. 

 

 
 

4. Enter the hostname or IP of the VoIP Gateway in the “Gateway Hostname or IP” field, and                                 
specify the SIP Port on which the gateway is operating. By default this is 5060. 

5. Specify the number and type of ports the gateway supports, i.e. analog, BRI, PRI or T1. This                                 
will set up one account for each port and enable the corresponding number of calls/lines for                               
that account.  

● An analog line supports 1 call. 
● A BRI port supports 2 calls. 
● An E1 (PRI) supports 30, and a T1 (PRI) supports 23. 

 
For example, if you specify 1 x T1 port, it will create one SIP account which can handle up to 23                                         
calls. Click “Next”. 
 

6. The individual ports will be “created” and displayed in a columnar format. 
● Virtual extension number – In effect the VoIP Gateway “converts” each line/port to                         

an extension, so that the phone system can receive and forward calls to it. The virtual                               
extension number is a number assigned by 3CX Phone System so that it can                           
address it as an extension. There is no need to change this field. 

● Authentication ID & Password – These values are used to authenticate the ports                         
with 3CX Phone System. 



● Channels – The Channels field shows how many simultaneous calls the port                       
supports. An analog line supports 1 call; a BRI port supports 2 calls, an E1 (PRI) 30,                                 
and a T1 (PRI) 23.  

● Port Identification – This field shows the identification number given to the port.                         
Here you can specify the number that was assigned by your telco provider. 

● Inbound Route Day/Night – If the port will receive inbound calls, you can specify to                             
which extension, ring group or digital receptionist a call must be routed. This can be                             
changed and extended to support multiple DIDs at a later stage. 

7. On the next page, you can create an outbound rule for the VoIP Gateway that is being                                 
configured. For example, you can have calls where the called number starts with a prefix                             
routed to this Gateway. Click “Finish” to create the VoIP Gateway. 

 
See Also 

● Configure BeroNet BeroFix /Small Business/ 400/1600/6400 – 1 or 4 BRI | GSM | FXO | FXS 
● Patton Smartnode 4112, 4114 – FXO (Analog lines) & FXS (fax) 
● Patton Smartnode 4970 – T1 & E1 (1 or 4 port) 
● Patton SmartNode 4120 – ISDN BRI (1 & 2 port) 
● Welltech WellGate 2540 – 4 port FXO or 4 port FXS 
● Welltech WellGate 2424s – 24 Port FXS 
● Welltech WellGate ATA 172plusPOE – 2 Port FXS (fax) 
● Connecting A SmartNode to the Network 
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Introduction 
Outbound and inbound rules dictate how 3CX Phone System routes calls based on certain criteria.                             
You can, for example, configure rules to control through which VoIP gateway or provider a call will                                 
be placed through, based on least cost routing, so that local calls go through your ISDN lines and                                   
international calls through your VoIP provider. You can also create DID (Direct Inward Dialing)                           
numbers which will allow you to place calls directly to a user’s extension, bypassing the receptionist                               
or IVR. 
 
Creating Outbound Call Rules 
An outbound rule denotes through which VoIP gateway/provider an outbound call should be placed.                           
Based on who is making the call, the number that is being dialled or the length of the number. 
 
When configuring a VoIP Gateway or a VoIP Provider, you will be asked to create an outbound rule                                   
that will be used to route calls to the Gateway or Provider. You can also edit these rules or create                                       
new ones from the outbound rules node. 
 



 
To create an outbound rule: 

1. From the 3CX Management Console menu under select “Outbound Rules” > “Add                       
Outbound Rule”, and enter a name for the new rule. 

2. Specify the criteria that should be matched for this outbound rule to be triggered with. In the                                 
“Apply this rule to these calls” section, specify any of the following options: 

● Calls to numbers starting with prefix – Apply this rule to all calls starting with the                               
number you specify. For example, enter 9 to specify that all calls starting with a 9 are                                 
outbound calls and should trigger this rule. Callers should dial “9123456” to reach                         
number “123456”. 

● Calls from extension(s) – Select this option to define a particular extension or                         
extensions range for which this rule applies. Specify one or more extensions                       
separated by commas, or specify a range using a , for example 100120. 

● Calls to Numbers with a length of – Select this option to apply the rule to numbers                                 
with a particular digit length, for example 8 digits. This way you can capture calls to                               
local area numbers or national numbers without requiring a prefix. 

● Calls from extension group – Rather than specifying individual extensions, you can                       
select an extension group. 

3. Now specify how outbound calls matching the criteria should be handled. In the “Make                           
outbound calls on” section, select up to three routes for the call. Each defined gateway or                               
provider will be listed as a possible route. If the first route is not available or busy, 3CX                                   
Phone System will automatically try the second route. 

The alternative Outbound Routes will have to be configured in order for calls to take these routes,                                 
when the first is unavailable. By default the second and third routes Block Calls. 
 



 

4. You can transform the number that matches the outbound rule before the call is routed to the                                 
selected gateway or provider using the “Strip Digits” and “Prepend” fields: 

● Strip digits – Allows you to remove one or more digits from the called number. Use                               
this to remove the prefix before a call is dialled on the gateway or provider if it is not                                     
required. In the example above, you would specify to remove one digit, in order to                             
remove the prefix “9” before it is dialled. 

● Prepend – Allows you to add one or more digits at the beginning of the number if this                                   
is required by the provider or gateway. 

5. You can configure these options per outbound rule, since a rule that applies to a VoIP                               
gateway connected to the local PSTN would normally require different criteria than a rule                           
that applies to a VoIP Provider. 

 
See our Outbound Rules – A Complete Example of how to create an outbound rule in 3CX Phone 
System. 
 
Creating DID Numbers / Inbound Rules 
Many companies provide users and/or departments with “Direct or DID numbers”, which allow their                           
contacts to call them directly, bypassing the receptionist. DID numbers are referred to as DDI                             
numbers in the United Kingdom and as MSN numbers in Germany. Even if you make use of a                                   
digital receptionist, a direct line / number is often preferable because it’s more convenient for the                               
caller. 
 

http://www.3cx.com/blog/voip-howto/outbound-rules-a-complete-example/


 

 
Direct dial numbers are easily implemented using “Inbound Rules”. DID numbers are provided by                           
your VoIP provider or Phone Company and are virtual numbers assigned to your physical lines.                             
Usually you are assigned a range of numbers, which are linked to an existing BRI/T1/E1. There will                                 
be an extra charge per number or per range, but this will be a fraction of the cost of adding physical                                         
lines. Enquire with your Phone Company or VoIP provider for more information about DID numbers. 
 
Adding DID’s 

 
 
To add a DID: 

1. From the 3CX Management Console, select  “Inbound Rules” > “Add DID”. 
2. Enter a name for the DID (for example Sales). Note: The DID name can be prepended or                                 

appended to the Caller ID so as to identify on which number a caller has called you from.                                   
You can enable this from the “Settings” > “General” > “Global options” page under                           



“Inbound name to Caller ID”. 
3. Under the new “Inbound Rule”, the “Inbound Rule Type” allows you to choose between a                             

DID/DDI or caller ID number mask. 
4. In the “DID/DDI Number/mask” field, enter the DID number as it will appear in the SIP “to”                                 

header (The number your provider has supplied as your main, or first, DID number). 3CX                             
Phone System will match the number inserted in this field with the “to” header, starting from                               
the last part of the received string, thus avoiding any differences in the format of the number.                                 
For example, if you are based in the UK and your DID number is 08452304024, then you                                 
can enter the number *2304024. This will match any DID number inserted in the “to” field                               
ending with these numbers, including +448452304024, 08452304024, 00448452304024,               
and, of course, *2304024. 

5. Select for which Gateway or Provider ports you wish to add this DID to. If the DID number is                                     
associated with multiple ports, then you must select each port. An inbound rule will be                             
created for each port that you select. 

6. Specify where you wish to direct calls made to this DID: 
● End Call 
● Connection to extension 
● Connect to Queue/Ring Group 
● Connect to Digital receptionist 
● Voicemail for extension 
● Forward to outside number 
● Send fax to email of extension 

7. You can specify that an incoming call is routed differently if it is received outside office hours.                                 
Deselect the “Same as during office hours” option to specify a different route. 

8. Click “OK” to create the DID / Inbound rule. 
 
Configuring Different Office Hours per DID 
Businesses working globally across different time zones, will want to configure different office hours                           
and holidays per DID.  
 
To do this: 

1. From the 3CX Management Console menu, click “Add” > “DID / Inbound route”. 
2. Give the rule a descriptive name. This will be used to identify which DID has been used                                 

when troubleshooting, as it can be seen in the logs. It will also be used for identifying which                                   
DID is being used to to make the call, and will be displayed in the Caller ID of the destination                                       
phone. This option can be selected, in the Global Options, to prepend the name of the DID. 

3. In the “DID number/mask” type in the number. This can be a whole number, or a wildcard,                                 
both formats will be considered for processing. For example 1235551234 or *234. 

 

 
 

4. Choose the provider/gateway port. This is used to identify over which line the call will be                               
coming in from. A VoIP provider will only have one available port. A VoIP (PSTN) Gateway,                               
will have one port for each physical line, depending on the make and model. FXO gateways                               
for example will have one port for each line. E1/T1 gateways will only have one port per                                 
gateway. 

 



 
 

5. In order to enable custom DID opening hours, uncheck the “Apply the same routing logic                             
Outside of office hours” box. 

 

 
 

6. Choose where you want to route out of office hours calls in the “Outside Office Hours”                               
section. 

 

 
 

7. Check “Set up Specific Office Hours”. This option will only be enabled if you disable                             
“Apply the same routing logic Outside of office hours”. Click “Set up Specific Office                           
Hours” to open up the dialog box. 

 

 
 

8. Set your office hours and click “OK”. 
9. Check “Play Holiday Prompt on Public Holiday” to play the holiday prompt whenever                         

there is a holiday.  
10. Click “OK” to accept the configuration of both the routing of the call as well as the opening                                   



hours of the DID. 
11. Go to the “Settings” node > “General”. 

 

 
 

12. In the “Office Hours” section click on “Configure Holidays”. This will open up a special                             
dialog box, where you can define holidays and record or select pre recorded .wav files to                               
play for the holidays. 

 
13. Give the Holiday a name, for example, “New Year”. 
14. Choose the date for the holiday, for example 1 January. Since New Years Day recurs every                               

year, you can choose “each” instead of a year. Holidays with a steady date each year can                                 
be defined like this. Dates which do not have a steady date each year can be defined as and                                     
when a holiday occurs, for example a bank holiday, you can define the current year or the                                 
next year. 

15. Choose a prompt to play for the Holiday. Click “Add”. 
16. Choose a prompt from the list of files already in the repository, and click “OK”. 
17. Click “Add” to add the holiday and prompt to the PBX. 
18. Click “OK” to exit the holiday configuration 
19. Click “OK” in the General Settings to save the configuration. 

 
Troubleshooting DID Numbers 
If you have created the DIDs, but calls are not being forwarded as expected, do the following: 

1. Go to the “Server Activity” log node in the 3CX Management Console. The Server Status 
screen lists current server activity and logs calls that are being received and for which 
number they were received on.  

2. Call the DID number that you configured, and monitor the Server Status log. You will see a 
line similar to: 
Incoming call from 1000 to <sip:789456123@3CXPhone System> 
where “1000” is the internal number of the line configured to receive calls from the VoIP 
Gateway or VoIP Provider and <sip:789456123@3CXPhone System> is the content of the 



“To” header of the INVITE, i.e. the intended recipient. (Note logging level should be set to 
Medium or Verbose to see additional messages.) 

3. Now analyse the “To” header carefully and ensure that the DID number you have dialled is 
present in the “To” header: <sip:789456123@3CXPhone System>. 

4. If you see a text ‘Review invite & adjust source identification’, you need to configure Source 
identification. See the chapter “Configuring a VoIP Provider / SIP Trunk” for more 
information. 

 
Exporting & Importing DIDs 
 
Exporting DIDs 
If you need to export your Inbound Rules to a .CSV file format to either save them as backup or to                                         
make changes to them, follow these steps: 

1. Log into the 3CX Management Console. 
2. Click on the “Inbound Rules” node and select the DID’s that you want to export. 
3. Click on the “Export” button to begin exporting your DID rules. 
4. Select a location and a file name for your exported DID rule file and click “Save”. Your rules                                   

will be exported and saved in the CSV file. 
 
Importing DIDs 
If you want to create multiple DID rules you can do so by creating the necessary fields on a CSV file                                         
using the correct format, then importing them back into 3CX by using the import function. 
To import your DIDs into 3CX from a CSV file follow these steps. 

1. Log into the 3CX Management Console. 
2. Click on the “Inbound Rules” node and click on the “Import” button. 
3. Browse to the file that contains the DID rules that you want to import, select it and click 

“Open”. 
4. The rules will be imported in 3CX Phone System. 

 
See Creating and Importing DIDs for more information. 
 
Caller ID Reformatting (Caller ID ReWrite) 
Here you can find more information about Caller ID Reformatting  
 
See Also 

● See our Outbound Rules – A Complete Example of how to create an outbound rules. 
● See Configuring a VoIP Provider / SIP Trunk for more information on source identification. 
● See how to create Extension Groups to add to outbound routes. 

 

http://www.3cx.com/docs/adding-voip-provider-sip-trunks/
http://www.3cx.com/blog/docs/importing-dids/
http://www.3cx.com/blog/docs/cid-formatting/
http://www.3cx.com/blog/voip-howto/outbound-rules-a-complete-example/
http://www.3cx.com/docs/adding-voip-provider-sip-trunks/
http://www.3cx.com/docs/extension-management/
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Introduction 
The digital receptionist feature allows 3CX Phone System to answer phone calls automatically.                         
When a call comes in to the phone system the caller is presented with a list of options. The caller                                       
can then choose the appropriate option using the numbers on their phone keypad. Using this                             
feature you can implement a menu.  
 
For example, “For sales press 1. For support press 2 or wait on the line to be transferred to the                                       
operator”. A digital receptionist is also known as an auto attendant. 
 
You can configure many different digital receptionists each with their own extension number.                         
Depending on your preferences you may configure these to answer calls based on which line the                               
call comes in from, as well on whether the call is received inside or outside office hours. For                                   
example, you can have a different prompt for outside office hours that does not include the options                                 
to be transferred to groups/queues that do not have agents available to take calls.  
 
Recording a Menu Prompt 
Before you create your digital receptionist, you must first write down the menu options you wish to                                 
offer the caller and then record the announcement. A simple example would be, “Welcome to                             
Company XYZ, For sales press 1. For support press 2 or stay on the line for an operator” 
 
Note: It is generally recommended to put the number the user should press after the option, i.e. “For                                   
sales, press 1”, rather than “press 1 for sales”. This is because the user will wait for the desired                                     
option and only then “register” what number to press. 
 
 
 
 
 
 
 
 



Creating a Digital Receptionist 
 

 
 
You can create multiple digital receptionists and link them to a particular line. To create a digital                                 
receptionist: 

1. In the 3CX Management Console menu, select “Digital Receptionist” > “Add Digital                       
Receptionist”. 

2. Specify a name and virtual extension number for the digital receptionist. 
3. Now click on the “Record” button and enter your extension number.  

● You will be called so that you can record the prompt. The file will be copied into the                                   
%allusersprofile%\3CX\Data\Ivr\Prompts or C:\ProgramData\3CX\Data\Ivr\Prompts     
directory depending on your OS.  

● Alternatively click on the browse button and specify a file that you previously                         
recorded. You must save the file in WAV format in PCM, 8 kHz, 16 bit, Mono format.                                 
(In Windows Sound Recorder you must use the “Save As” option to save this format)                             
Do not use MP3 format.  

4. Specify the menu options. Select the appropriate key, and then select from the available                           
actions. Then specify the extension number or virtual extension number (virtual extension                       
number in the case of Ring Group, Call Queue or to another Digital receptionist) 

5. The last option, Timeout, allows you to specify how long the system should wait for an input.                                 
If it receives no input, it will automatically perform this action. This is handy for callers who                                 



did not understand the menu or who do not have a DTMF capable phone. When ready, click                                 
“OK” to save the digital receptionist. 

 
Allowing Callers to Dial a Known Extension Directly 
Whilst a digital receptionist prompt is playing, a caller can enter the extension number directly to be                                 
connected to an extension immediately. This allows callers who know their party’s extension to                           
avoid going through a receptionist. This option is enabled by default. If you wish to make use of this                                     
feature simply instruct your callers by explaining this in the voice prompt. 
 
For example, “Welcome to Company XYZ. If you know your party's extension number, you may                             
enter it now, otherwise, for sales press 1. For support press 2”.  
 
Call by Name 
Using a Digital Receptionist, you can also direct callers to the call by name function. This allows                                 
them to find the person they wish to speak to by entering the first letters of the person’s last name                                       
on the phone dial pad. The call by name function requires: 

1. A selfidentification message for the user. Users without a selfidentification message are not                         
accessible via the callbyname feature. 

2.  Users can not have a last name with Unicode characters. 
3. The Callbyname menu feature must be made available from a Digital Receptionist as one                           

of the menu options. 
 
SelfIdentification Message 
To record your selfidentification message: 

1. Go to your voicemail menu (Default 999). 
2. Enter your voicemail PIN number. 
3. Go to the options menu (‘9’ key). 
4. Press ‘5’ key to record the self ID message. 
5. Record your name only, i.e. “Sarah Jones”. 

 
How it Works 
The Callbyname feature uses the last name of the user and compares it with the input (that has                                   
been entered on the phone keypad). The following rules are used: 
 

● The last name is converted to uppercase. 
● All symbols except [29] and [AZ] are ignored. 
● The following translations for symbols are used: 

● 'ABC2' => '2' 
● 'DEF3’ => '3' 
● 'GHI4' => '4' 
● 'JKL5' => '5' 
● 'MNO6' => '6' 
● 'PQRS7' => '7' 
● 'TUV8' => '8' 
● 'WXYZ9' => '9' 

 
The caller has to type a minimum of three digits (‘0’ – ‘9’) to call to a user. Digits ‘0’ and ‘1’ are                                             
ignored, but can be used to call users with short last names (for example, to access someone with                                   



the last name ‘Li’, you can type ‘540’). 
 
After the user has entered three digits, IVR queries the phone system database for matching users.                               
If there are no matching users, you hear “extension not found”. If there is only one matching user,                                   
the IVR plays “Please hold while I transfer your call” and redirects the call to the chosen extension.                                   
If there are more than one matching user, the IVR will wait for additional digits to be entered by the                                       
caller, for 2 seconds. 

● If IVR waits for additional digits (more than one matching user) and caller presses any digit,                               
the IVR will add this digit to the current input and check currently matching users. If there are                                   
no matching users, the IVR will play “extension not found”. 

● If the user does not input any more digits (2 seconds elapsed or ‘#’ has been pressed) and                                   
more than one user is matched, then the IVR will play: “To call Van Damme press 0. To call                                     
Van Halen press 1. To exit press pound, (#)”. In this example ‘Van Damme’ and ‘Van Halen’                                 
are the selfidentification prompts of the matching users. 

 
Exchange Server IVR Integration 
 
Note: Requires 3CX Pro Edition License. 
 
Exchange Server 2013 SP1 includes a voicemail and an IVR feature that can be interesting to use                                 
for companies that deploy Microsoft Exchange Server. The Exchange IVR feature allows you to                           
leverage speech recognition in your company’s IVR. The voicemail feature allows you to convert                           
voicemails to text and forward them via email. 
 
More information on Configuring MS Exchange Server 2013 Unified Messaging with 3CX Phone 
System is available on this page. 
 
See Also 

● See our 3CX Online Training: Digital Receptionists video and see first hand how to setup                             
and configure your Auto Attendant. 

http://www.3cx.com/blog/docs/exchange-server-2013-config/
http://www.3cx.com/blog/docs/exchange-server-2013-config/
http://www.3cx.com/blog/training-videos/digitial-receptionists/
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Introduction 
The Ring Groups / Paging and Intercom features add powerful capabilities to your PBX. Ring                             
groups will help you to never miss that important customer call, whilst the Paging feature allows you                                 
to make announcements to groups of people rather like a PA system. 
 

 
 
Ring Groups 
A ring group allows you to direct calls to a group of extensions. For example, you could define a                                     
group of three sales people, and have the general sales number “DID” ring on all three extensions                                 
at the same time or after each other. When you create a ring group, you assign it a virtual extension                                       



number. This will be the number used by the phone system to “address” the ring group. 
 
To add a ring group: 

1. In the 3CX Management Console, select “Ring Groups” > “Add Ring Group”. 
2. Now enter the ring group options: 

● Virtual extension number – This number identifies the ring group from other                       
extensions. Keep the automatically generated extension number, or specify a new                     
one as needed. Do not specify an existing extension number. 

● Name – Enter a friendly name for the ring group. 
● Ring strategy – Select the appropriate ring strategy for this ring group: 

○ Prioritised Hunt – This will start ringing on the first extension, then the second                           
etc. 

○ Ring all – All phones will ring at the same time 
○ Paging – This will page all extensions part of the group (see next section) 

● Ring time – Specify how long the phones should ring for. 
3. In the section “Ring group members” specify the extensions that should be part of this ring                               

group. Simply click on the extensions to the left and click on the “Add” button to add them to                                     
the ring group. Move the extensions up or down to configure the priority of an extension. 

4. In the section “Destination if no answer”, you can define what should happen if the call                               
does not get answered by the ring group. 

 
Paging 
Paging allows someone to ring a group of extensions and make an announcement via the phone                               
speaker. The called party will not need to pick up the handset as the audio will be played via the                                       
phones speaker. The person paging will not hear any audio back from the people being paged. Both                                 
paging and intercom features require a phone that supports intercom and that is configured to allow                               
it. To add a paging group: 
 

1. Click on “Ring Groups” > “Add Ring Group” option to bring up the “Add Ring Group”                               
page. 

2. Now enter the ring group options: 
● Virtual extension number – Specify an extension number which will be used for this                           

paging group. 
● Name – Enter a friendly name for the ring group. 
● Ring strategy – Select the “Paging” ring strategy. 
● Ring time – Specify how long the phones should ring for. 

3. If you have phones that support multicast, and you have a very large installation with                             
specialized requirements, you can enable the Multicast option. For most installations this                       
option is not required. 

4. In the “Ring group members” section specify the extensions that should be part of this                             
paging ring group. Simply click on the extensions and click on “Add” to make them a                               
member. 

 
Important: Before using the Paging or Intercom feature make sure that you have specified the                             
paging/intercom prefix number by: 

1. From the 3CX Management Console, select “Settings” > “Advanced” > “Dial Codes” tab                         
and adding the paging prefix in the “Paging” field (*11 for example).  

2. Make sure that the user who is trying to page a group has the right to do so, select                                     



“Extensions” > “Edit Extension” > “Rights”, Check the “Can Intercom” option in                       
“Rights currently assigned” section. 

 
Note: The “Ring time” and “Destination if no answer” options will be ignored, since they are not                                 
relevant for paging. 
 
Intercom 
The intercom feature allows a phone system user to make an announcement to a single extension.                               
In this scenario the audio is two way, and the called party can respond immediately without picking                                 
up the handset. To call a user via the intercom function: 
 

1. Prefix the extension you wish to call with the paging/intercom prefix (that you specified in                             
“Settings” > “Advanced” > “Dial codes” > “Paging” field), followed by the extension                         
number. For example you specified the paging prefix to be *11 to make an intercom call to                                 
extension 100 you should dial: *11100. 

2. You can now announce your message. 
 
See Also 

● Learn about  Busy Lamp Field (BLF) – What it is and how it works 

● Learn about Dial Codes and how to program them 

http://www.3cx.com/blog/voip-howto/busy-lamp-field/
http://www.3cx.com/blog/extension-user-manual/dial-codes/
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Introduction 
Call Queues allow calls to be queued whilst agents (members of a call queue) answer calls. Calls                                 
do not go unanswered but wait in a queue until an agent is available to take the call.  
 
For example, you can define a group of three sales people, and have the general sales number                                 
route to a sales call queue. If all three sales people are busy, callers will be kept in the queue until                                         
the next sales person is free.  
 
When you create a call queue, you also assign it a virtual extension number. This will be the number                                     
used by the phone system to “address” the Call Queue. 
 
Creating a Call Queue 

 
 
To add a Call Queue: 
 
In the 3CX Phone Management Console, select “Call Queues” > “Add Queue”. Now enter the                             
call queue options: 

1. Virtual extension number – Optionally change the suggested virtual extension number. Note                       
that this extension number will be automatically created. Do not specify an existing extension                           
number. 

2. Name – Enter a friendly name for the Queue. 
3. Polling strategy – This option allows you to choose how calls should be distributed to agents: 

● Hunt random start – 3CX will randomly choose an agent to distribute the call to. This                               
will evenly distribute the calls to each of the agents. 



● Ring All – The phones of ALL the agents will ring. 
● Prioritised Hunt – 3CX will distribute the call according to the order specified in the                             

Queue members section. All calls will go to the first agent first, and only if this agent                                 
is busy, it will go to the next agent. This strategy can be used to set up skills based                                     
routing, by ordering the agents according to their skills. 

4. Ring timeout – Indicate the timeout in seconds, i.e. for how long the phone should keep                               
ringing before it considers the call unanswered by that agent. 

 
Configuring Queue Options 
You can configure advanced queue options such as destination if no answer, maximum queue                           
length is reached and maximum queue waiting time is reached. 

 
1. In the “Destination if no answer” section, you can define what should happen if the call                               

does not get answered by an agent. If no agent is logged into the queue, this option gets                                   
triggered immediately. In addition, this option gets triggered if the caller presses the ‘*’                           
button on his phone. This gives callers an option to exit out of the queue and leave a                                   
message. 

2. In the “Other options” section, you can specify a custom introduction prompt and a custom                             
music on hold file. You can now choose whether to play the full intro prompt before the                                 
system starts to call queue agents. You can also decide whether you wish to announce a                               
caller’s position in the queue and what the maximum wait time should be. 

 



Adding Agents 

 
 
Now go to the Agents tab to specify the extensions that should be part of this Call queue.  
 

1. Click on the extensions and click on “Add” to make them a member. Move the extensions                               
up or down to configure the priority of an extension. 

2. To add an Agent that is connected via an external number click the “Add” button next to                                 
“Add External Agent Number”. Fill in the external agent’s details (an extension will also be                             
created for the external agent). Click “OK” when done and the external agent will be added                               
to your queue. 

 
In addition to being a member, an extension/user must also login to start answering calls                             
routed to this call queue. Users can login to a call queue using the login button in the                                   
3CXPhone or via a schedule using the Office Hours Schedule. 
 
Advanced (PRO Edition) 
3CX Phone System Pro Edition adds additional Call Centre like features. No further installation is                             
required – you just purchase the module, reactivate your existing key and the additional call queue                               
features will become available. 
 



 
Additional Queue Strategies 
With the Pro edition, you have these additional Queue strategies: 

● Longest Waiting Time – Will forward a call to the agent who has been waiting the longest to                                   
take a call. 

● Least Talk Time – Will forward the call to the agent with the least total talk time. 
● Fewest Answered – Will forward the call to the agent that has answered the least number of                                 

calls. 
● Hunt by threes prioritized – Will forward the call to the top 3 agents (as configured in the call                                     

queue agent section simultaneously). 
● Hunt by threes random start – Will send call to 3 random agents simultaneously. 
● Round Robin – Will target only active agents, that are logged into the queue, in round robin                                 

manner, i.e. first call will be sent to agent 1, the second call to agent 2 and so on. 
 
Additional Queue Options 
 
In the PRO edition, you have additional options that you can configure: 

● You can enable a Callback option – This allows callers to hang up and get called back when                                   
it’s their turn. This option requires that you specify an outbound rule to which the configured                               
prefix, matching the rule, is used to trigger the call. The Callback option can be requested by                                 
the caller (Option 2) or it can be offered, if the timeout of the queue is reached.  

● You can specify the wrap up time in seconds – This gives the agent time to enter notes into                                     



the call record after taking a call. 
● You can specify the maximum number of callers in the queue – When this is reached, the                                 

caller will be routed according to the setting in the “Destination if no answer” section. 
● Reset Queue statistics – Detailed statistics for the queue, such as average call time,                           

average wait time and so on are visible through the Presence and Queue Monitoring                           
function of 3CXPhone. You can reset the Agent Call Statistics for the Queue by clicking the                               
“Reset” button. This is also available in 3CX Wallboard. 

● Call statistics can also be reset automatically using a preconfigured schedule. 
● Priority Queue – The administrator can configure this queue as a priority queue. This is                             

useful when the same people are part of two queues, and calls on one of the queues should                                   
receive priority over calls in the other queue. For example, a support team might have one                               
line (and one queue) for normal support calls, and another line (a different queue) for VIP                               
customers. Both queues are serviced by the same people. The queue for VIP customers will                             
have the “Priority Queue” feature enabled. 

● Give Caller ability to opt out of recording: This gives the option to the caller to press DTMF 3                                     
to stop being recorded during a call. 

● Configure SLA Time . 
● Queue Notifications – Various notifications can be enabled so that the Queue Manager is                           

notified when certain conditions are encountered, such as the SLA time has been breached,                           
or a call in the Queue has been lost. 

 
See Also 

● See your 3CX Online Training: Call Queues and find out from the experts how to set them 
up. 

● Read our guide on Managing Queue Calls using the presence screen built into the 
3CXPhone for Windows. 

http://www.3cx.com/blog/training-videos/call-queues/
http://www.3cx.com/user-manual/queue-calls/
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Introduction 
3CX Phone System includes a fax server that allows you to receive faxes. 3CX Fax Server is based                                   
on the T.38 standard protocol and requires a compatible supported T.38 VoIP gateway or provider.                             
VoIP providers and gateways must be configured according to our configuration guides, so that fax                             
reception is enabled. It is also possible to use a VoIP provider that does not support the T.38                                   
protocol, however, the quality of the fax implementation between VoIP providers varies and                         
therefore can not be guaranteed. 
 
Fax Receiving Configuration 

 
To receive faxes, you must configure a line or a DID to be dedicated for receiving of faxes, so that                                       
all calls on this number are forwarded to the 3CX Fax Server. The 3CX Fax Server will then receive                                     



the fax, convert it to PDF and email the fax to the configured email address. To configure fax                                   
reception: 
 

1. In the 3CX Management Console, select the Inbound rule for the port or DID which will be                                 
dedicated for receiving faxes. 

2. From the “Office hours” routing options, select “Send fax to email of extension”. 
3. Select the extension that should receive incoming faxes. If you select “Default Email                         

Address”, incoming faxes will be sent to the email address configured for the virtual fax                             
extension number. You can configure the email address of the default virtual fax extension                           
from the “Fax Machines” and select  “888” then click “Edit Fax Extension”. 

4. Alternatively you can forward incoming faxes to the email address configured for a user’s                           
extension. This even allows you to create multiple DID rules and give personal fax numbers. 

 
Configuring Fax Machines / Fax Servers 
The “Fax machines” node in the management console lists all known “Fax extensions” including                           
the extension used by the 3CX Fax Server. These “Fax extensions” are similar to a normal                               
extension and require an authentication ID and password to login to the SIP server. 
3CX Phone System included a preconfigured fax extension (ext: 888). This extension is used by                             
the 3CX Fax Server for incoming fax calls, which will then be routed to an email address. In                                   
addition, 3CX Phone System can be configured to proxy fax calls (T.38 traffic) to a fax machine                                 
connected to an ATA or another software based T.38 fax server, by creating additional fax                             
extension. 
 
Step 1: Creating a Fax Extension 

 
To create a new fax extension: 

1. In the 3CX Management Console, select “Fax machines” > “Add Fax Extension”. 
2. In the “Fax Server Extension Number” field, specify the fax extension number. Any calls                           

forwarded to this extension will be assumed to be a fax and receive a fax tone. 
3. Specify the Fax Server Authentication ID and Password – These credentials will be used by                             

the ATA / 3rd party fax server to login to 3CX Phone System. 
4. If this extension is used by the 3CX Fax Server, you can specify the default email address to                                   

which all faxes should be sent to. 
5. If this extension is used for an ATA or 3rd party T.38 fax software, the extension will be used                                     

only to register to the SIP server and receive T.38 fax traffic.  
6. If the fax extension is created to be used for an ATA or 3rd party T.38 fax software, you can                                       

configure the “Outbound Caller ID” to be sent when an Outgoing Fax call is made.  
 
Note: You must restart the fax service for these changes to take effect. 



 
Step 2: Connecting a Fax Machine using an ATA to the Fax Extension 
Once you have configured the fax extension you can connect the fax machine to a supported ATA 
device and configure the ATA device to connect to the fax extension. The guide Configure Your Fax 
Machine with 3CX Phone System outlines this process step by step. 
 
See Also 

● Find out How to Setup Inbound Fax Routing in 3CX Phone System. 
● Read more about Fax Configuration with 3CX Phone System. 

 

http://www.3cx.com/docs/configure-fax-machine-with-3cx/
http://www.3cx.com/docs/configure-fax-machine-with-3cx/
http://www.3cx.com/blog/docs/inbound-fax-routing/
http://www.3cx.com/support/fax-configuration/
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Introduction 
Call conferencing allows you to easily configure up to eight conference calls that can allow a total of                                   
64 callers (license permitting). The 64 caller limit is for all conferences, not per conference. Although                               
many conference call services exist, it’s often easier and cheaper to host your own audio                             
conferences. To simplify the setup of conference calls, conferences can be setup ad hoc, without                             
the need to reserve a conference room. 
 
3CX WebMeeting 
In addition to standard voice conferencing, 3CX Phone System also has an advanced web / video                               
conferencing feature called 3CX WebMeeting. 3CX Webmeeting is based on the number of                         
concurrent participants you wish to host. 
 
Call Conferencing 
Configuring Conferencing 

1. In the 3CX Management Console, expand the “Settings” > node, select “PBX” and switch                           
to the “Conferencing” tab. 

2. Specify the conferencing extension number. This is the number that users must call to setup                             
and connect to a conference. 

3. Specify whether to require a PIN to create a conference. If you enable this, users that create                                 
a conference must enter this conference PIN, after the Conference ID. The PIN will be used                               
automatically when a user creates the conference via 3CXPhone. 

 
Creating a Conference Call 
Conference calls can be created using one of the following methods: 

1. From 3CXPhone, the user can create an ad hoc conference. For more information how to do                               
this see the online user manual: 

○ 3CXPhone for Windows  
○ 3CXPhone for Mac 
○ 3CXPhone for Android 
○ 3CXPhone for iOS 

From the Conference section in 3CXPhone, the user can also schedule conference calls to                           
occur in the future. Users will receive an email with the conference call details. External                             

http://www.3cx.com/docs/webmeeting-manual/
http://www.3cx.com/user-manual/call-conference/
http://www.3cx.com/user-manual/call-conference-mac/
http://www.3cx.com/user-manual/call-conference-android/
http://www.3cx.com/user-manual/call-conference-iphone/


users need to be notified by the conference creator. 
2. Users can also create conference calls using their IP phones. They will need to dial the                               

Conference Extension number (700) by default, and follow the prompts. 
 
See the guide for information on how to Create an Adhoc Conference Call using your Desk Phone. 
 
Web Conferencing / Webmeeting 
3CX Phone System has a powerful video conferencing feature called 3CX WebMeeting, which                         
allows you can to host video conferences for up to 10 (Standard) or 25 (PRO) participants. You can                                   
license additional participants if you wish. See 3CX WebMeeting Pricing to find out the full pricing                               
structure and other available 3CX WebMeeting versions. Follow these steps to configure 3CX                         
WebMeeting on your 3CX Phone System: 
 
Step 1  Enable the 3CX WebMeeting Feature 
 

1. Navigate to the “WebMeeting” node. 
2. Webmeeting Settings dialog will launch automatically. 
3. Select the Region that applies to you. 
4. Choose a web meeting location that is the closest to you. 
5. Enter your Company URL, normally the company name. This URL will be shown in the                             

meeting invites, i.e. the link that users will click on.  
6. The Admin extension will be selected automatically and a password will be auto generated. 
7. Click the “Enable Webmeeting” button. An account will be created and dedicated to your                           

organization. 
 
Step 2  Enable users to use WebMeeting 
 
All users in your organization will be able to organize webmeetings automatically.  

 
If you want to disable this feature for some selected users, uncheck the checkbox next to the                                 
Extension that will not be creating Webmeetings.   
 
Organizing web meetings from 3CXPhone 
Users that have a 3CX WebMeeting user account created, are now able to organize and schedule                               
web meeting sessions. All this can be done from within 3CXPhone. Start 3CXPhone for Windows or                               
Mac and click on the “Conference” tab in the bottom operations toolbar. Two new options will be                                 
visible at this point: “Create WebMeeting” and “Scheduled WebMeetings”.  
 
See Also 

● Read how to Create an Adhoc Conference Call using your Desk Phone. 
● How to create a Conference Call from 3CXPhone: Windows, Mac, Android, iOS. 
● Find more information about Hosting a 3CX WebMeeting. 

http://www.3cx.com/blog/voip-howto/create-conference-using-desk-phone/
http://www.3cx.com/ordering/pricing/webmeeting/
http://www.3cx.com/blog/voip-howto/create-conference-using-desk-phone/
http://www.3cx.com/user-manual/call-conference/
http://www.3cx.com/user-manual/call-conference-mac
http://www.3cx.com/user-manual/call-conference-android/
http://www.3cx.com/user-manual/call-conference-iphone/
http://www.3cx.com/user-manual/hosting-web-conference/


● How to Join a 3CX WebMeeting  
● See also “Organizing Video Conferences” section in the User Manual. 

http://www.3cx.com/user-manual/webmeeting/joining-a-webconference
http://www.3cx.com/user-manual/
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Introduction 
3CX Phone System allows you to delegate access to the 3CX Management Console; managerial                           
tasks can be shared with department heads, or an IT Administrator may have access to manage the                                 
company’s extensions. The level of access can be adjusted depending on what the user needs to                               
have access to. Managerial tasks can now be delegated and divided between a group of individuals,                               
rather than one administrator, allowing 3CX Phone System to be managed more efficiently. 
 
Configuring Extension Access Permissions 
To configure an extension’s Management Console access: 

1. From the 3CX Management Console, select the “Extensions” node.  
2. Select the extension you want to grant access and click “Edit extension”.  
3. Switch to the “Options” tab and set a 3CX Web Access password (provide it to the user of                                   

that extension). 
 
The user can then login into the 3CX Management Console using their extension number as the                               
username and the password you set for them. 
 
The following sections are a number of sample use cases that outline how to configure 3CX Phone                                 
System, for each case: 
 
Use Case 1: Allow Power Users to Manage their own Extensions 
Power users can be allowed access to the management console to configure their extensions’                           
parameters, such as edit their voice mail PIN number and configure their email notifications.  
 

 
To do this:  



1. From the “Extensions” node > Choose the extension then either double click the extension                           
or click on “Edit Extension” from the top menu, switch to the “Options” tab and check the                                 
“Allow 3CX Management Console Access” checkbox. 

2. Click the “Configure Permissions” button. 
 

 
 

3. From the dialog window choose “Manage own Extension” and click “OK”. 
4. Click “Apply” to save Changes. 

 
By allowing a user to manage his/her own extension, they can: 

● Edit their email address and mobile phone number. 
● Configure voicemail options such as disable PIN authentication to listen to messages, or edit                           

PIN number. 
● Configure email notifications such as whether to receive voicemails as email attachments                       

and receive email notification on missed calls. 
● Configure voicemail greetings. 

 
Use Case 2: Allow Department Heads to Manage their Departments Extensions 
Department heads can be allowed to manage users in their department. This allows the head of a                                 
call center for example, to control which extensions are allowed to make external calls, or                             
enable/disable the recording of calls.  
 



 
 
To give access to a department head: 
 

1. From the “Options” tab, check the “Allow 3CX Management Console Access” checkbox. 
2. Click the “Configure Permissions” button. 
3. From the dialog window choose “Group / Department Manager” and click “OK”. 
4. Click “Apply” to save Changes. 

 
By allowing Group / Department Manager access, the user can: 

● Create, edit and manage extensions within the extension group(s) that they belong to. 
● Control which extensions are allowed to make external calls. 
● Enable/disable the recording of calls. 
● Log in/out agents from Queues. 
● Configure forwarding rules for extensions. 

 
Use Case 3: Allow Access to an IT Administrator to Manage Company Extensions 
A company’s IT administrator can be given access to create and manage his company’s extensions.                             
This is especially useful in a hosted server environment where the System Administrator is in                             
charge of updates, system settings and daytoday extension management tasks.  
 



 
 
To do this: 

1. From the “Options” tab, check the “Allow 3CX Management Console Access” checkbox. 
2. Click the “Configure Permissions” button. 
3. From the dialog window choose “Global Extension Manager” and click “OK”. 
4. Click “Apply” to save Changes. 

 
By allowing Global Extension Manager access, the user can: 

● Create and edit and manage extensions. Includes all the points from the previous use cases. 
● Create and edit and manage extension groups. 

 
Use Case 4: Access to VoIP/Trunks and System Administrator 
In addition to managing his company’s extensions, the IT administrator can be given access to                             
add/edit VoIP/Trunks and be given System Administrator access. Access to these two options can                           
be given independently of each other.  

● Users with access to “VoIP / Trunk” can configure VoIP Gateways, VoIP Providers and 3CX                             
Phone System Bridges.  

● Users with “System Administrator” access can modify system extensions (Queues, Ring                     
Groups, Digital Receptionists), and also have access to Settings and Updates.  

 



To enable access to these options: 
1. From the “Options” tab, check the “Allow 3CX Management Console Access” checkbox. 
2. Click the “Configure Permissions” button. 
3. From the dialog window check “VoIP / Trunk Administrator” and/or “System                     

Administrator”, click “OK”. 
4. Click “Apply” to save Changes. 

 
By allowing access to VoIP/Trunks and System Administration, the user can: 

● Configure VoIP Gateways, VoIP Providers and 3CX Phone System Bridges (VoIP / Trunk). 
● Modify system extensions: Queues, Ring Groups, Digital Receptionists (Sys Admin). 
● Access to the System node, where Network, Security, General and Advanced settings reside                         

(Sys Admin). 
● Access and perform system updates (Sys Admin). 

 
See Also 

● See the guide on Extension Management for more information about giving access rights to                           
users. 

 

http://www.3cx.com/docs/extension-management/
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Introduction 
You can connect two separate 3CX Phone Systems together, allowing you to make calls between                             
branch offices for free just by utilizing your existing internet connection.  
 
A “Bridge” can be assigned a prefix, which you will dial to access the other 3CX Phone System. This                                     
prefix must be followed by the extension number you wish to reach on the other 3CX Phone                                 
System. 
 
Alternatively, you can assign the extensions in one Office to start with one number (e.g. 100, 101,                                 
102 where all extensions start with 1), and the extensions in the second Office to start with a                                   
different number (e.g. 200, 201, 202 where all extensions start with 2). This way, users from one                                 
office can directly dial the extension number without using a prefix making calling between offices or                               
branches seamless. In this case, when the outbound rule is created, you must ensure that the prefix                                 
corresponds to the numbering plan selected and that no digits are stripped. 
 
Creating a Bridge 
A bridge can have 2 types: “Master” or “Slave”. When you create a bridge between 2 3CX Phone                                   
Systems, one end must be configured as a “Master” and the other end must be configured as a                                   
“Slave”.  
 
When you create a bridge between two 3CX Phone Systems ensure that you first create the Master                                 
endpoint on one 3CX, and then create the Slave endpoint on the other 3CX. Follow this order when                                   
creating bridges to get the connection working quicker.  
 
Step 1: Create a Bridge on the Master Phone System 
 



 
 

1. In the 3CX Management Console go to “Bridges” node and click "Add Bridge". 
2. Enter a name for the bridge and take note of the virtual extension number. (You will need                                 

this number when you create the “Slave” Bridge connection so ensure that the virtual                           
extension number generated is not in use on the other 3CX Phone System which will host                               
the “Slave” bridge endpoint). 

3. Type of 3CX Bridge  choose “Master”. 
4. Specify a prefix to be used for this bridge. If you specify 6, then a you must dial 6100 to                                       

reach extension 100 on the other 3CX Phone System. You can also dial 600 to reach                               
extension 600. This prefix is also used to redial missed calls between offices.  

5. Authentication Password – The password that will be used for authentication. 
 

 
6. The “Allow Tunneled Connection” option allows all SIP and RTP traffic to be sent via a                               

single TCP port. The 3CX Tunnel vastly simplifies firewall configuration, reduces bandwidth                       
and also secures your phone calls.  

● If “Allow tunneled connection” is enabled, enter the public IP address or FQDN of the                             
“Slave” 3CX Phone System. In the example above “office2.3cx.com” is the FQDN of                         
the office in New York. 

● Configure the 3CX Tunnel port of the New York 3CX Phone System. By default this                             
is 5090. However in multiple instances installations or cloud installation this port will                         
differ for each instance.  

 

 
7. Select if you want to publish and/or receive presence information to/from the New York 3CX                             

Phone System.  
● Publish Information is available in Standard and Pro.  
● Receive information is available only with a  Pro Edition license. 



 

 
8. Configure the protocol (http or https) to be used to transfer presence data between 3CX                             

Phone Systems and enter the FQDN of the remote 3CX. (If a tunneled connection is                             
configured, this will be automatically populated). If the webserver of the New York 3CX                           
Phone System is running on non default HTTP/HTTPS ports  example 5000 or 5001, then                             
you need to specify the port after the FQDN example: 
● If the HTTP Port of the second pbx is 5000, specify: office2.3cx.com:5000 
● If the HTTPS Port of the second pbx is 5001, specify: office2.3cx.com:5001 

9. Select the users that are able to see this remote connection from within their 3CXPhone.  
10. Accept all other defaults and click “Next” to create the bridge. 
11. The “Outbound Rules” dialog will be presented. If a prefix was configured in the bridge                             

Bridge type section, the same prefix will be automatically used for the outbound rule prefix                             
and the bridge route will be set automatically. By default Strip Digits will be set to 1. You can                                     
change this setting and if you choose an extension numbering plan that does not require you                               
to strip the prefix, set Strip Digits to 0.  

 
Step 2: Create a Bridge on the Slave Phone System 

 
 

1. In the 3CX Management Console of the “Slave” 3CX Phone System, Select the “Bridges”                           
node and click "Add Bridge". 

2. Enter a name for the bridge and assign the same virtual extension number as the one                               
configured on the Master 3CX Phone System. 

3. Type of 3CX Bridge  choose “Slave”. 
4. Specify a prefix to be used for this bridge. I.e. if you specify 7, then a you must dial 7100 to                                         

reach extension 100 on the other 3CX Phone System. It could also be that the extensions on                                 
the other pbx start with 7 example 706, 708 etc.  

5. Enter the Public IP or FQDN of the “Master” 3CX Phone System and the port. 
 



 
○ If you selected “Use tunneled connection” in the port field you have to enter the                             

Master’s Tunnel port e.g 5090. 

 
○ If “Use tunneled connection” is not selected, then this slave connection is a direct                           

bridge so in the port you have to enter the Master’s SIP port e.g 5060. 
6. Authentication Password – The password configured on the “Master” 3CX Phone System                       

Bridge. 
7. Select if you want to publish and receive presence information from the other 3CX Phone                             

System 
8. Configure the protocol, url and users for 3CX Presence.  
9. Accept all other defaults and click “Next” to create the bridge. 
10. If you have specified a prefix, the “Outbound Rules” window will open and automatically                           

configure your chosen prefix as the outbound route for the new bridge. By default Strip                             
Digits will be set to 1. You can change this setting and if you choose an extension numbering                                   
plan that does not require you to strip the prefix, set Strip Digits to 0. 

 
See Also 

● Troubleshooting Remote Extensions and VoIP Providers Using the 3CX Firewall Checker. 
● Take a look at the 3CX Advanced Training: Bridge Configuration video. 
● Find a full guide on the  3CX Tunnel / 3CX Session Border Controller . 

http://www.3cx.com/blog/docs/firewall-checker/
http://www.3cx.com/3cxacademy/videos/advanced/3cx-bridge-configuration/
http://www.3cx.com/docs/3cx-tunnel-session-border-controller/
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Introduction 
The phonebook feature allows you to easily publish a phonebook company wide. Used in tandem 
with a personal phonebook, it allows users to quickly launch calls without wasting time finding a 
contact’s number and subsequently entering it in the phone. 
 
The Company phonebook is company wide and is managed from the management console. The                           
personal phonebook is only available to a particular extension and is managed from 3CXPhone on                             
that extension. 
 
Synchronize the Phonebook With your IP Phones 
The company phonebook is also published to a directory in a format that Cisco, Fanvil, Htek,                               
Polycom, snom, and Yealink phones can download. These phones can then show the same                           
phonebook on their display. 
 
Resolves Caller ID to Name 
One of the most important features of the phonebook is that incoming caller IDs are searched                               
against the phonebook, and if a match is found, the caller’s name is shown in the caller ID rather                                     
than just showing the number. 
 
Using the Phonebook 
To use the phonebook, users enter a name, or part of the name, in the search box of the 3CXPhone                                       
Phonebook. 3CXPhone will automatically resolve the name or part of the name to a phonebook                             
entry. To launch a call, the user just needs to doubleclick the name and click the “Call” button. 
 
Link to Exchange Server, LDAP or ODBC 
The 3CX Phonebook / Directory service can also synchronize with and query external data sources                             
including Microsoft Exchange Server, a Microsoft LDAP server or an ODBC database.  



Import & Export of Phonebook entries 
 
Importing Phonebook Entries 
You can import phonebook entries from a CSV file. Each entry should be on a new line, and the                                     
fields separated by a comma as follows:  

● “First name, Last name, Company, Mobile, Mobile2, Home, Home2, etc”  
You can download a Sample Phonebook .csv and populate it with your phonebook entries. 
 
To import the company phonebook entries into 3CX Phone System do the following: 
 

1. Log into the 3CX Management Console and click on the “Settings” node. 
2. Click on “Company Phonebook” and select “Import”. 
3. Browse to your saved CSV file, select it and click “Open”. 
4. Your Company Phonebook entries will be imported into 3CX. 

 
Exporting Phonebook Entries 
You can export your phonebook entries from the Company Phonebook in order to save them as a                                 
backup or to modify them and import them back at a later stage. To export your phonebook entries                                   
follow these steps: 
 

1. Log into the 3CX Management Console and click on the “Settings” node. 
2.  Click on “Company Phonebook” and click the “Export” button. 
3. Select a file location and a file name for your CSV file. 
4. Click “Save” to export and save your Company Phonebook. 

 
Note: By default 3CX will match at least 6 numbers to a phonebook entry before it considers the                                   
number a match. You can change this number by going to “Phonebook options” in the Phonebook                               
node.  
 
Synchronising with Exchange Server (PRO) 
 
The 3CX Company Directory Service allows the Exchange Connector to connect the 3CX                         
Phonebook with Microsoft Exchange Server 2013 SP1 and Office 365 (with Exchange) to import                           
Exchange contacts to either the company or the personal phonebook. The following import functions                           
are available: 
 

● Ability to select a public folder of contacts to be imported into the 3CX Company Phonebook. 
● Ability to import personal contacts from one or more Exchange users and import them to                             

their personal 3CX Phonebook. 
 
How it Works 
3CX Phone System will connect to Microsoft Exchange Server via an “Impersonated User Account”                           
and import all the contacts from Exchange. Once per day (at 4am), the connector will login to the                                   
Exchange Server and check if there are any new updates to existing contacts, new contacts or to                                 
check where contacts need to be deleted. 
 
IMPORTANT: 3CX Phone System will sync the contacts from Exchange to 3CX. If you want to                               
make changes, then you need to make them at Exchange level first. 3CX Phone System will not                                 

http://downloads.3cx.com/downloads/misc/ImportCompanyPhonebookSampleV125.csv


allow you to edit an imported contact.  
 
Configuring the Exchange Connector (MS Exchange Sync) 
In order to configure 3CX Phone System to work and synchronize with Microsoft Exchange you will 
first need to Create an Impersonated Microsoft Exchange User Account. 
 
After configuring 3CX MS Exchange Sync section by following these steps: 
 

 
 

1. Log in to your 3CX Management Console, select the “Settings > Directory Search” node,                           
and click the “Exchange” tab. 

2. Fill in the following fields: 
○ FULL FQDN to OWA of the Microsoft Exchange Server. Office 365 users will need to                             

use https://outlook.office365.com/owa. 
○ Insert your impersonated account details in the “Impersonated User Account” and                     

“User Account Password” fields. 
3. Select the email address and the public folders that you want synchronized and click                           

“Apply”. 
4. To check if your Exchange contacts have been synchronized with the 3CX Phone System                           

Company Phonebook go to “Settings” and then select “Company Phonebook”. 
5. You should see a list of contacts in the 3CX Company Phonebook imported from the email                               

address that you selected to synchronize. 
 
Enabling Exchange Calendar Profile Switching 
After having successfully configured MS Exchange Sync, you can take advantage of the ability to                             
automatically change your extension status, based on your status in the Outlook calendar (requires                           
Exchange version 2013 SP1). If you have scheduled appointments where your “Show As” status is                             
set to “Working Elsewhere” (only exchange 2013) or “Out Of Office”, then your status in 3CX Phone                                 
System will automatically change to the “Away” or “Out Of Office” status respectively.  

http://www.3cx.com/blog/docs/how-to-create-impersonated-user


 
To enable this feature, select “Settings” > “Directory Search” > “Exchange” and check the “Enable                             
Calendar Profile Switching” checkbox. A full guide on How to Use Exchange Calendar Status                           
Synchronization details this process. 
 
Configuring LDAP Directory Search (PRO) 
 
LDAP (Lightweight Directory Access Protocol) Directory Search has the ability to connect with an                           
external directory server, for instance, your company's Microsoft active directory. When an incoming                         
call is received, 3CX Phone System can access LDAP and look for a contact match. If a match is                                     
found, the contact will be automatically added to the 3CX Company Phonebook and the contact                             
information will be displayed for subsequent calls made by this caller.  
 

 
 
To Configure LDAP Directory Search with 3CX Phone System: 
 

1. Log in to the 3CX Management Console and click on the “Settings > Directory Search”                             
node. Click on the “LDAP” tab. 

2. Specify 
○ Fill in the LDAP server IP address or FQDN as in the example above. 
○ Insert the LDAP server port number  default 389 
○ Insert the LDAP User name and User Password. 
○ Specify your LDAP search base. In this example we used “OU=User, DC=test,                       

DC=local” which means that the LDAP search will take place in the User contacts                           
container, in the “test.local” domain.  

○ Add a number of days that these contacts will be kept inside the 3CX Phone Book.                               
Default is 1 year. 

3. When you receive a call, 3CX Phone System will search for a match in the the 3CX                                 
Company phonebook. If a match is not found then it will contact the LDAP server. If a match                                   
is found, it will be automatically added to the 3CX Company Phonebook. 

 

http://www.3cx.com/docs/exchange-calendar-status-synchronization/
http://www.3cx.com/docs/exchange-calendar-status-synchronization/


Configuring ODBC Database Search (PRO) 
3CX Phone System has an ODBC Search function that allows 3CX Phone System to connect to any                                 
data source which can be accessed via an ODBC driver. In this way any database driven ERP or                                   
CRM can import contact data from the shared database when an incoming call is received. See our                                 
detailed stepbystep configuration guide on How to Setup Company Directory Synchronization                        
ODBC Search. 
 
See Also 

● See how to Create an Impersonated Account Microsoft Exchange User Account. 
● Find a full guide on How to Use Exchange Calendar Status Synchronization. 
● See our user manual on Using the 3CX Phonebook. 

 

http://www.3cx.com/docs/odbc-search-phonebook-directory/
http://www.3cx.com/docs/odbc-search-phonebook-directory/
http://www.3cx.com/blog/docs/how-to-create-impersonated-user.
http://www.3cx.com/docs/exchange-calendar-status-synchronization/
http://www.3cx.com/user-manual/phonebook/
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Introduction 
The Call Reporting feature can be configured to send an email containing specific report statistics                             
about calls to and from 3CX Phone System. Reports can be sent out ad hoc or be scheduled to be                                       
sent out daily, weekly on specific days or on the first day of the week. You can also receive these                                       
reports in various formats, PDF, CSV, HTML, Rich text format and XML. 
 
The following report types are available: 
 

● Call Log  View statistics about calls to and from 3CX Phone System.  
● Extension Statistics  See reports about calls to and from specific extensions. 
● Call Cost by Extension Group  Run reports on groups to see call costs. 
● Call Cost by Call Type  Specify extensions and see their call costs. 
● Ring Group Statistics  See information about calls to ring groups. 
● Basic Queue Statistics  See how your queues are performing.  

 
Note: To access advanced call reports you require a 3CX Pro Edition license. These reports                             
provide more detailed information on Detailed Queue Statistics, Team Statistics, Queue                     
Performance Overview, Graphs, Lost calls, Call Distribution, Abandoned Calls, SLA Statistics,                     
Callback Statistics, Breached Calls, Agent Statistics, Login history of Agents and other reports                         
useful in Call Center scenarios.  
 
Creating Reports 
Reports are generated and sent automatically by email, so that report creation can be executed as a                                 
low priority process and will not interfere with the phone system.  
 

 
 
To create a report and receive it by email: 



1. From the 3CX Management Console, select the “Call Reports” node.  
2. From the report drop down menu choose the type of report to run. 
3. Type a name for your report. 

 
4. Depending on the type of report, you will see various options that you can configure. For                               

example: 
● If you choose to run an “Extension Statistics Report” you can choose to generate a                             

report for all extensions, a single extension or a range of extensions.  
● You can also choose a time range for your report. A Custom range allows you to                               

customize the date and time from when the report should be generated. Other                         
options include generation for calls made “Today”, “Yesterday”, “Last week”, “Last 7                       
days” or “Last 30 days”.  

● For these types of report you can also choose to capture specific call types, for                             
example, “Internal calls”, “External calls” or “All calls”. Click on “Next”. 

 
5. Configure your prefered Report Format from the drop down list.   

 



 
 

6. Enter the email address that will receive the report. 
7. From the frequency drop down box choose whether to run the report “One time now”,                             

schedule the report to run “Daily”, “First day of each week” or “Weekly” on specific days. 
8. If you have chosen to run the report “One time now” click the “Email now” button at the                                   

bottom to run the report and email it immediately. If you have chosen any other frequency for                                 
the report then click the “Save and Schedule” button. 

9. Depending on the configured schedule, an email will be sent. Click the “Download” button to                             
retrieve the report.  

Manage your Scheduled Reports  

 
 
If you have chosen to schedule reports, they will appear under the “Scheduled Reports” node.                             
From here you can edit your scheduled tasks reports or delete them. 
 
Custom Report Settings  

 



The “Settings” subnode allows you to change the logo that is used when reports are generated.  
You may also choose to clear call log records since a specific date, delete daily or last week’s call                                     
logs, or simply delete all call logs. 
 
See Also 

● Find more information on Customizing Email Templates.  
 

http://www.3cx.com/blog/docs/customizing-email-templates/
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Introduction 
3CX Phone System is easy to monitor for any Windows administrator, since it behaves just like any                                 
other Windows Server application. You can monitor 3CX Phone System using your favourite                         
network monitoring solution, for example ActiveXperts or Microsoft Operations manager. 
 
Things to Monitor 
 
System Extensions 

 
 
3CX Phone System uses system extensions for services such as IVR, Queue, Fax, Parking and so                               
on. Using the “System Status” > “System Extensions” node in the 3CX Management Console                           
you can quickly monitor if all the system extensions are working and registered correctly. 
 



3CX Services 

 
 
A good first check is to monitor that all 3CX services are running. You can view all 3CX services                                     
from the “System Status” > “Services” node in the 3CX Management Console. Any network                           
monitoring package can monitor Windows services remotely. 
 
Server Events 
 

 
 
You can configure email alerts to be sent to you for critical events from the “Settings” > “Email” >                                     



“Email &  Notifications” tab. 
 
Troubleshooting 
To troubleshoot 3CX Phone System you can use the Activity log and Event logs inside the                               
Troubleshooting node. 
 
Activity Log 

 
 
Monitor the Activity Log to troubleshoot issues. It shows the activity of the server, and logs potential                                 
reasons for error conditions. The Activity Log allows you to easily filter based on an Extension, or a                                   
particular call. In addition, you can filter the logging by date and time.  

 
Click the “Logging” button to enable verbose logging which will show whole SIP messages and                             
debug information. You can also configure for how many days to keep backup logs. 
Note: Verbose logging consumes a lot of disk space and uses more processing power. It is                               
important to change the level back to low or medium after the troubleshooting session is complete.   
 
Event Log 
The following server events are posted to the log: 



 
● A person dialling the Emergency number (ID 4099). 
● Changes to the status of a SIP Trunk (ID 4100). 
● A trunk failover occurs, i.e. the backup rule is triggered (ID 12289). 
● A Trunk or VoIP provider account responds with an error code (ID 12294)  This could                               

happen if your account is inactive or reached the credit limit. 
● Upon registration or unregistering of an IP phone (ID 4101). 
● The licence limit has been reached (ID 8193). The 3CX license limit on concurrent calls. If                               

this event occurs frequently you should consider upgrading your license. 
● An IP is blacklisted (ID 12290) – This can happen if an IP has reached the maximum number                                   

of failed authentication attempts. Frequently this points to a hacking attempt. 
● An IP is blacklisted because of too many requests (ID 12292) – This happens if the web                                 

server antihacking module blocks an IP because of too many requests.  
● A Call Back request is triggered by the queue module (ID 102). 
● Failure of a DNS resolution  (ID 12293)  This event occurs when the remote VoIP provider                                 

could not be contacted. This could occur when your internet connection is down or the                             
specified IP or FQDN for the VoIP provider is incorrect or down. 

● Failure of resolving an IP via STUN (ID 12295) – This happens when the STUN server is                                 
down. This event will also be triggered when the internet goes down. 

 
See Also 

● See how to use the Activity Log to Identify Why a Call is Not Reaching its Destination 
● See our Support Procedure for Troubleshooting Remote Extensions.  
● Also find a 3CX Online Training: Basic Troubleshooting video to assist you to identify and 

resolve issues. 

http://www.3cx.com/blog/docs/server-activity-log-example-1/
http://www.3cx.com/blog/docs/troubleshooting-using-3cxphone/
http://www.3cx.com/blog/training-videos/basic-troubleshooting/
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Introduction 
3CX includes the 3CX Tunnel allowing easier bridging of remote 3CX Phone Systems and                           
connecting remote extensions. The 3CX Tunnel combines all SIP (signaling) and RTP (media) VoIP                           
Packets from one location and delivers them to and from another location (typically the PBX Server)                               
using a custom TCP protocol. This simple concept allows 3CX to overcome firewall or telecom                             
provider issues. The 3CX Tunnel can be used for the following reasons: 
 

● Resolve issues of NAT Traversal at both the remote and the PBX location. 
● Simplified Firewall configuration at both the remote and the PBX location. 
● Overcome difficulties with ISPs that block VoIP Traffic based on port numbers. 
● Allows VoIPoverWiFi in some restricted locations, such as Hotel rooms. 
● “Fixes” Firewalls that cannot handle VoIP traffic correctly or which are very problematic to                           

configure correctly, such as Microsoft ISA Server 
 
Note: Presence information does not get carried through the Tunnel to the remote network as of                               
yet. Make sure that the HTTP/HTTPS ports you have chosen during the installation are open on the                                 
PBX server side. 
 
How it Works 

 
The 3CX Tunnel 

 
The image above demonstrates how the 3CX Tunnel works. In this example, 3CX Phone System is                               
on IP Address 10.0.0.181, and listens on TCP port 5090 (by default) for incoming Tunnel traffic. We                                 
must set up a single Port Forwarding rule on the Modem or NAT/Firewall Device, telling it that all                                   
incoming TCP traffic received on port 5090 should be delivered to LAN IP Address 10.0.0.181. 
 
The remote setup is shown on the left hand side of the cloud. In this example, the machine with IP                                       
address of 192.168.0.2 has 3CXPhone installed. We will need to tell the VoIP Phone the public IP                                 
address of the PBX Server (which in this case is 213.165.190.51), and also the private IP address of                                   
the PBX Server (which in this case is 10.0.0.181). Since the 3CXPhone will by default use the                                 



standard port numbers used by 3CX Phone System, typically no further configuration will be                           
necessary. 
 
3CX Tunnel technology can be used in the following scenarios: 
 

● Connect Remote Sites using the SBC  For remote sites with a number of remote phones,                               
you can deploy the 3CX SBC to the site so that all phones will communicate with the 3CX                                   
PBX over a single port. This is also the preferred option in case 3CX Phone System is                                 
running in the cloud. 

● Connect Remote 3CXPhone Users  3CXPhone for Windows, Mac, iOS and Android have                         
a built in tunnel that will be used automatically when 3CXPhone detects it is not on the LAN.                                   
No configuration is necessary in 3CXPhone.  

● Connect 3CX Phone Systems via a Bridge  When creating a Bridge to another 3CX                             
Phone System, you can choose to use the 3CX Tunnel rather than a direct connection.  

 
Configuring the Tunnel 
We will use the above example in “How the 3CX Tunnel Works” to configure a tunnel connection. 
 
Step 1 – Configure the PBX 
In the 3CX Management Console, select  “Settings” > “Security” > “3CX Tunnel” tab. 

1. Configure the Tunnel Password (e.g. “r6W4Qi”) 
2. Set the Local IP to the Local IP Address of the NIC, which will be receiving tunnel                                 

connections. If the PBX has only one NIC, then there will be no need to set this field. In our                                       
example this is 192.168.9.213. 

3. Set the Tunnel Listening Port to the port, which will be receiving tunnel connections. The                             
default value is 5090. 

4. Click “OK”. The Tunnel service will be restarted automatically. 
 
Step 2 – Configure the Firewall 
The Tunnel protocol is designed to eliminate NAT traversal problems and reduce Firewall                         
configuration work to a minimum. There is only one Firewall setting that needs to be made – we                                   
must forward the TCP Tunnel port (set by default to 5090) to the PBX. 
 

 
Configuring a Port Forward Rule in pfSense 



 
The above picture shows configuration for a pfSense firewall  most firewalls will provide similar                             
functionality. In your firewall: 
 

1. Enable Port Forwarding. 
2. Specify the PBX’s Local IP Address (which we had set previously to 192.168.9.213) 
3. Set the Type to “TCP/UDP”. 
4. Set the Port Range to be from 5090 to 5090 (only one port). 
5. Set the Comment field to “3CX Tunnel”. 
6. Click on the “Add” button followed by the “Apply” button. Your firewall configuration is now                             

done! 
 
Step 3 – Configuring Remote Sites via 3CX SBC, 3CXPhone, Bridges  
After you have configured the local tunnel connection and the firewall, the tunnel is now “ready for                                 
use”. At the client side you must configure the 3CXPhones, an SBC or the Bridges accordingly. 
 
3CX SBC (Session Border Controller) 
The 3CX SBC is suitable for sites with multiple IP Phones in the same LAN. The SBC must be                                     
installed at the remote site and is available for Windows and Raspberry Pi: 
 

● Installing 3CX Session Border Controller for Windows 
● Installing 3CX SBC Session Border Controller for Raspberry Pi. 

 
3CXPhone Clients 
No configuration is necessary for 3CXPhone clients. However to view 3CX Tunnel options, see the                             
chapter “Configuring the 3CX Phone System Clients – 3CXPhone”. 
 
3CX Bridges 
To configure a Bridge using the 3CX Tunnel, see the Chapter “Connecting 3CX  Bridges”. 
 
See Also 

● Configuring a SIP Desk Phone as a Tunnelled External Extension with 3CX Phone System. 
 

http://www.3cx.com/docs/3cx-sbc-windows/
http://www.3cx.com/docs/3cx-sbc-raspberry-pi/
http://www.3cx.com/docs/3cxphone-deployment-administration/
http://www.3cx.com/docs/connecting-offices-bridges/
http://www.3cx.com/blog/voip-howto/configuring-sip-phone-as-tunnelled-external-extension/
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Introduction 
With the 3CX WebRTC Gateway feature you can share a WebRTC call link with anyone via chat or                                   
email allowing them to place a call from any open standards browser (Chrome, Firefox), directly to                               
your extension, without needing to install a client. You can also configure links or buttons on your                                 
website to enable visitors to call extensions directly from your site.  
 
Important Note: To be able to configure WebRTC call links, you need to make sure that you have a                                     
Public IP Address and have configured a correct and resolvable FQDN during the setup of your 3CX                                 
Phone System. 
 
Step 1: Configure WebRTC Links for your Extensions 
Enable WebRTC links for your extensions. You will then be able to use these links from browsers                                 
that support WebRTC to receive calls directly to extensions. 

 
1. In the 3CX Management console go to “Settings” > “Click to Call (WebRTC)”. 
2. Select the extensions that you wish to enable Click to Call for. A random DID string will be                                   

generated. You can leave it as is, or modify it to make it easy to remember. In this example                                     
we modified the string and renamed it to “support”. Note: The DID mask you enter must not                                 
contain any special characters. Use only numbers from 09 and lowercase letters from az. 

3. Proceed to enable WebRTC links for your Call Queues, Ring Groups, and Digital                         
Receptionists.  

4. Click “Apply” to save. 



Step 2: Firewall Configuration  Port Forwarding for WebRTC 
Go to your firewall and port forward the following range of ports UDP 92569500. See our guides on                                   
Firewall & Router Configuration for more information.  
 
Note: You can directly open ports UDP 90009500. These ports are shared for Audio Calls                             
(90009250) and WebRTC Calls (92569500).  
 
After you have completed these changes, you can successfully give the WebRTC Url to anyone, via                               
email, chat or add it to your email signature. Callers from outside your network, can simply click on                                   
the WebRTC Url, and reach the enabled extension, queue or digital receptionist from a WebRTC                             
Standards browser without installing a SIP Client.  
 
Step 3: Putting Click to Call links on your website 
If you want to publish links on your website to allow “Click to Call”, then you must whitelist your                                     
website’s IP in the WebRTC gateway configuration.  
 

 
 

1. In the 3CX Management Console, navigate to “Settings > Click 2 Call (WebRTC )” node. 
2. Click on the “Trusted Apps” button and type the Public IP Address of your website. Click                               

“Add”. Click “OK” to save changes. 
3. Now you can go to your website and add Call Buttons which trigger requests to WebRTC                               

Url’s.  
4. When customers click on the link, the WebRTC client page will open up in their browser.                               

They will need to Allow use of microphone and camera and then click “Call Now” to place the                                   
call.  

 

http://www.3cx.com/docs/firewall-router-configuration-voip/


 
 
See Also 

● See How to share your WebRTC Call Link that will allow others to call you. 
● Elevate a Call to a Video Call – Include video in your call (3CXPhone for Windows). 
● Share your Screen – Conduct demonstrations or collaborate remotely (3CXPhone for                     

Windows). 
● Enabling chat in a WebRTC Call – Pass on written information to your callers (3CXPhone for                               

Windows). 
● See Installing 3CX Phone System for instructions on setting up your FQDN. 

http://www.3cx.com/user-manual/webrtc-call-link/
http://www.3cx.com/user-manual/webrtc-video-call/
http://www.3cx.com/user-manual/share-screen-3cxphone/
http://www.3cx.com/user-manual/enable-chat-webrtc-call/
http://www.3cx.com/docs/installing-3cx/
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Introduction 
3CX Phone System has an integrated backup and restore functionality, to allow you to: 
 

● Create regular backups. 
● Allow for easy upgrades to newer versions of 3CX Phone System. 
● Allow hasslefree moving from one machine to another. 
● Configure a standby server for fault tolerance. 

 

 
 
Backing up your System 
To backup your system, you will need to decide where, what and when to backup your PBX. 
 

● Where: Choose between local drive or remote FTP 
● What: System configuration, Voice Mail, Recordings etc. 
● When: Oneoff or at scheduled intervals 

 
To take backups, the services will not need to be stopped. Nonetheless we recommend doing it at 
off peak hours.  
 
Step 1: Choose a Location to Store Backups 
3CX will save and restore backups to a central backup location. This backup location can be remote 
or local.  To choose a location to store backups:  



 

 
 

1. Launch the 3CX Management Console and select the “Backup and Restore” node. 
2. Click on “Location”, to configure the location for backups. Select the location type and 

configure accordingly: 
○ “Local disk”  Click the browse button to choose the location. 
○ “FTP”  Enter the path to the FTP server and a username and password for the 

account that has rights to access the FTP folder. 
3. Click “OK” to save the location. 

 
Any backups that will be created will be stored to this location and shown in the backup repository 
window. You can then download or delete backups from there.  
 
Step 2: Creating a Backup 
 

 
 
To create a backup: 

1. Go to the “Backup and Restore” node and press the “Backup” button. 
2. Specify a name for the backup.  
3. Select the items you would like to backup. 
4. Click the “Save” button to start the backup immediately. Once the backup completes click                           

“Close”. The new backup details will appear in the backup repository window. 
 



 
 
To schedule a backup: 
 

1. Go to the “Backup and Restore” node and press the “Backup Schedule” button. 
2. Choose what to backup and then choose between “Daily” or “Weekly” specifying the time.  
3. Choose a backup rotation  this is the number of backups to keep before overwriting the                               

oldest. For example, if you choose a weekly backup schedule and a rotation of 4, you will                                 
always have 4 backups to restore from, going back 4 weeks. 

4. Press “Save”, to schedule your backup. 
 
Restoring a Backup 
You can restore a backup immediately, in case you wish to move 3CX Phone System to another                                 
server or upgrade from an old version. Alternatively you can schedule a restore choosing whether                             
3CX should start the services after the restore or not. The main purpose of a scheduled restore is to                                     
keep a second system on standby with up to date configuration and user data.  
 
TIP: If you have backups from a previous version or another installation you can put them into the                                   
location you chose to store your backups. 3CX will recognize them and you will be able to use them                                     
and restore them. 
 
Note: Restoring a backup stops all the 3CX Phone System Services.  
 
Immediate restore 
To perform an immediate restore: 



1. Click on “Backup & Restore” node, select which backup to restore and click the “Restore”                             
button. A window will open warning you that all the services will be stopped during the                               
restore process. Click “Yes” to restore or “No” to cancel.  

2. The management console will logout and the restore will proceed. You will then have to log                               
back in once the restore is complete.  

 

 
 
Scheduled restore 
A scheduled restore is used for keeping a second server on standby and up to date with the latest 
data and configuration.To perform a scheduled restore, click on the “Restore Schedule” toolbar 
button. 
 

1. Go to Backup & Restore node, click on the “Restore Schedule” button. 
2. Select when to start the restore process (Daily or weekly) and at what time.  
3. Select whether you want to start the 3CX Services after the restore or not.  
4. The backup that you have scheduled will be restored (called 3CXScheduledBackup.zip).                     

Manually triggered backups are NOT restored automatically. 
 
Configuring a Failover machine 
 
It is possible to configure a second server to act as a hot standby server in case of a failure of the 
hardware on which 3CX Phone System is installed.  
 
In order to be able to configure Failover correctly, the following is required: 
 

● A single FQDN resolvable locally and externally 
● A 3CX Phone System PRO edition 
● A correctly configured backup and restore schedule 
● SIP Trunks configured to allow a registration to occur from the backup server 
● A DNS server that you can script to change the IP of your FQDN 



Step 1  Configure Failover tests & Interval 
 

 
 
To configure failover: 
 

1. Login to management console of the STANDBY SERVER. 
2. Go to the Backup & Restore node, select “Failover”. 
3. Enable Failover checkbox. 
4. Press on the button “Configure Restore Scheduling”. This is required for Failover. Note:                         

When this is enabled, Backup Schedule is automatically turned OFF.  
5. Enter the IP address of the main/active server. 
6. Select which services to monitor from the following: SIP Server, Web Server or Tunnel                           

Server.  
7. Specify the time interval between tests. In this example we set it to 15 seconds. This means                                 

that every 15 seconds, the standby server will perform the tests. If one or more tests fail,                                 
failover will occur.   

8. Configure whether you want failover to occur when all selected tests fail or when at least one                                 
of the selected tests fail.  



Step 2: Edit/Write the script that should run upon Failover 
 
When failover occurs, 3CX Phone System can launch a script before and after the services are                               
started on the standby server. Generally you will include in the “Pre Failover Script”: 
 

● Commands to update the DNS to the standby server IP 
● Commands to shut down the remote machine in case not all services are down 

 
You can also run a post Failover script to create a series of alerts or other commands such as                                     
activating gateways. 
 
See Also 

● Backup and Restore of Virtual PBX Instances  learn how to backup and restore your 3CX 
Phone System Virtual PBX instances. 

● Find an upgrade procedure from previous versions in our Installing 3CX Phone System for 
Windows guide 

 
 

http://www.3cx.com/docs/virtual-pbx-backup-restore/
http://www.3cx.com/docs/installing-3cx/
http://www.3cx.com/docs/installing-3cx/

	Admin_Manual_EN
	0.Copyrightpage
	00.TableofContents
	01.IntroductionLicensingSupport
	02.Installing3CXPhoneSystem
	03.FirewallConfiguration
	04.Configuringtheclients-3CXPhone
	05.ConfiguringManagingIPPhones
	06.ExtensionManagement
	07.ConfiguringVoIPProviderSIPtrunk
	08.ConfiguringVoIPGateways
	09.TrunkManagement
	10.ConfiguringDigitalReceptionistIVR
	11.ConfiguringRingGroupsPagingIntercom
	12.ConfiguringCallQueues
	13.ConfiguringFax
	14.ConfiguringWebCallConferencing
	15.Delegating3CXManagementConsoleAccess
	16.Connecting3CX-Bridges
	17.ThePhoneBookDirectoryservice
	18.CallReporting
	19.MonitoringyourPhoneSystem
	20.3CXTunnel3CXSessionBorderController
	21.ConfigureWebRTCGateway
	22.BackupandRestore

